
Welcome to KeyNote
Warning: This Help file is hopelessly outdated and incomplete. You will find some useful 
information here, but not all that you are looking for. For up-to-date details, please see the file 
"history.txt" included with KeyNote, and the FAQ section on the website: 
http://www.lodz.pdi.net/~eristic/free/keynote_faq.html

Keynote is a flexible, multi-featured tabbed notebook, based on Windows standard 
RichEdit control. It's always acessible with a single keypress, even if you work in 
another application. It's certainly more fun to use than pen and paper! A large number of
text formatting functions allows you to create very readable, clear, and well-organized 
notes.

The basic idea in KeyNote is that you can have many separate notes within a 
single file. This means that you do not need to open several files - for most purposes it 
is enough to create only one file and several notes inside it. With the addition of the 
tree-type notes, you now have a three-dimensional notebook: many notes within one 
file and a multi-level, nested pages within a single note. (Read more about KeyNote 
files)

Optionally, KeyNote can encrypt your data securely using the Blowfish or Idea 
algorithms. Keynote's interface and behavior are extremely configurable. 

KeyNote is as simple to use as any text editor, but if you want, you can use many 
advanced functions that KeyNote offers, such as sending notes via email, glossary, 
hyperlinks, macros, styles, plugins, virtual nodes, and much more.

KeyNote is free, and will always remain so. Do not pay for it!

See also:
KeyNote is an Open-Source project
Quick Start
Feature Highlights
Hints and Tips
Frequently Asked Questions

Note: This Help file is a work in progress. It is not yet complete.

The concept of KeyNote is based on a similar tabbed notebook application I have been using for 
several years: Dart Notes, by Andre v.d. Merwe. KeyNote can open and save files in Dart Notes format. 
Click here for more information if you have used Dart Notes before.



KeyNote is Open-Source
As of version 1.0, KeyNote has become an Open-Source project. You can download full source code for 
KeyNote from the author's website.

KeyNote - the binary file and the source code - are licensed to you on the conditions set forth in Mozilla 
Public License (MPL). You can only use KeyNote and its source code if you agree to and abide by the 
conditions of this license.

A special, separate project has been established for the purpose of open-source development of 
KeyNote. If you'd like to join the team, point your browser to http://keynote.sourceforge.net .



What's New
KeyNote is updated very often - more often that this Help file. A very detailed list of changes and additions
in the latest release is contained in the file called "History.txt". The file is located in the "\doc" subdirectory,
below the directory where KeyNote is installed.

You can also view the latest version of the Release History file on the Web:
http://www.lodz.pdi.net/~eristic/free/keynote_history.html



Quick Start
Click the "File" menu, then click the "New File" command to create a new file. A new KeyNote file 
will be created, with a single, default note. This is the file where you will be keeping your notes. Each file 
can contain one or more notes. By default, the file is saved automatically, so you don't have to remember 
about clicking the "Save" button - although you can if you want to.

To add more notes to the file: click the "Note" menu, then click the "New Note" command. A dialog box 
will be displayed, where you can: 

(a) enter the name for the new note
(b) select the icon for the new note
(c) chose the kind of note you want: simple editor or a tree-type note.

TIP: Right-click the editor area to display a context menu with frequently used commands.

TIP: KeyNote is distributed with a file "sample.knt", which contains additional information, tips and 
examples of KeyNote's capabilities. If you have upgraded KeyNote to a newer version, I recommend that 
you have a look at this file. If this is the first time you have installed KeyNote, the sample file will be 
opened for you automatically.

What are tree-type notes?
A tree-type note has a tree panel on the left-hand side, and the normal editor on the right-hand side. The 
tree panel looks and behaves similarly to the tree in Windows Explorer, except that in KeyNote, each 
branch of the tree (also called "node") can hold a separate node. When a new tree-type note is created, 
the tree has only one node. You can add as many nodes to the tree as you want, and you can arrange 
them in a convenient hierarchy. To create a new node, click the tree panel and press Enter. You can move
nodes within the tree by dragging and dropping tem.

TIP: Right-click the tree panel to display a context menu with frequently used commands.

Click here to read more about KeyNote editor.
Click here to read more about the tree-type notes.
Click here to read more about KeyNote files.

· You can resize the program window if it is too small or too big by dragging an edge of the window with 
the mouse.

· You can use the Formatting toolbar above to change the appearance of the text. You can change the 
font face, size, color and style attributes such as bold, italic, underline, or strikethrough. You can 
even highlight the text by pressing Ctrl+H.

· The Format menu contains additional formatting functions. You can set the alignment of the text (left, 
right or centered), change the spacing between lines, or change the colors of background and text.

· The program supports all standard Windows text editing commands. Press Ctrl+C to copy text to 
clipboard, Ctrl+X to cut text, Ctrl+V to paste text rom clipboard, Ctrl+A to select all text in a note.

· Press Ctrl+N to create a new note in current file.
· Press F2 to rename the current note or choose a different icon for the note.
· Press F4 to customize the look of the current note.
· Press Ctrl+O to open a Note file that already exists on your disk.
· Press Ctrl+Shift+P to print the note that is currently displayed.
· Press Ctrl+Shift+E to send the current note to someone via email.
· By default, you can minimize the program just by pressing the ESC key. This is much faster than finding

the tiny Minimize button with the mouse. However, if you find that you often minimize the program 
accidentally, you can turn this feature off in Options (press F5, click the "Miscellaneous" tab, and 
choose the desired action for ESC key in the "Escape key" field.

· After you minimize the program, see how it responds to the hotkey. Click the Minimize button, and then 



press the default hotkey combination: Shift+Ctrl+F12. This should cause the program to pop up to 
front, so you don't have to always use the mouse!

· Press F4 to change the properties of the note you are reading, such as its name, the icon that is 
displayed on the tab, default font and color and other options. Press F6 to use the same dialog box to 
change default properties for all new notes you create.

· If you just want to rename the note, press F2 or double-click the tab where the name of the note is 
shown.

· Press Ctrl+F to search for text in this note, or in all notes in the current file. Press F3 to repeat the last 
search.

· Press F5 to open the Options dialog box. There are many configuration settings you can change. For 
instance, you can specify whether your Notes file should be saved automatically; what file should be 
opened when you start the program; the hotkey used to bring the program window to front when it is 
minimized; whether the program should place its icon in the system tray... and many others!



Features
· RichText enabled editor, with many text formatting functions 
· Store many separate notes within one file; each note is displayed on its own, 

easily accessible tab. This is a much more convenient solution than opening 
several files on disk. Each note has independent font, color and editor settings. 

· Choose between two types of notes: a simpler, editor-only note, or a tree-type 
note, which is a multi-level hierarchy of "branches", each with its own 
independent note. The two types of notes can be mixed freely within one file. 
Click here for more information on tree-type notes.

· Tree type notes can be arranged horizontally (tree panel to the left of editor) or 
vertically (tree panel above the editor) 

· Ability to create user-defined styles for text and paragraph properties (More)
· Convenient keyboard shortcuts for all editing and file management commands 
· Option to minimize to system tray 
· Configurable activation hotkey to bring the program window to front after it was 

minimized to the system tray 
· You can protect your data files with secure encryption using a strong cipher: 

Blowfish or IDEA (More)
· Integration with WordWeb, a freeware dictionary/thesaurus program (see 

http://wordweb.co.uk/free)    (More)
· Many uses can share KeyNote on one computer, with the ability to have 

independent personalized settings for each user (More)
· Clickable URLs in the editor; users can configure what happens when an URL is

clicked 
· Simple file manager to quickly open often-used files    (More)
· Export and import files (as plain text or RTF) 
· Ability to merge two KeyNote files 
· Extremely configurable interface 
· Ability to create "virtual nodes" in the tree (nodes which are dynamically linked 

to external text or RTF files) 
· Ability to print notes 
· Ability to send notes via E-mail, incl. a simple address book and signature 

handling    (More)
· Ability to change icons that are assigned to notes (user-defined icons can be 

extracted from .ICO, .BMP, .EXE and .DLL files) 
· "Clipboard capture" feature, enabling you to automatically capture and store 

any text that was copied to Clipboard in another Windows application    (More)
· Expression evaluation    (More)
· Text highlighting 
· Glossary function to automatically replace a piece of text with another ("Expand 

text") 
· Function to insert special characters 
· A "match bracket" function 
· ROT-13, reverse text, repeat last edit command, join and sort lines... 
· Support for drag-and-drop file operations (including the ability to drag files from



Windows Explorer) 
· Find and Replace commands, with a single note or global scope 
· Clickable hyperlinks to Internet addresses, local files and location in KeyNote 

notes    (More)
· Dockable toolbars 
· Text statistics 
· Simple bookmarks 
· Plugin support, for extending the functionality of the program    (More)
· Macro support, including macros automatically executed on creating a new file 

or adding a note    (More)
· Configurable ability to minimize program or automatically close current file after a

predefined period of inactivity 
· Ability to specify default properties for all newly created notes, or selectively 

for notes added to a particular file    (More)
· Import and export files in the format used by other freeware notebook-type 

programs: DartNotes and TreePad 
· Unlimited number of notes that can be stored in a single file or a single tree-

type note. 
· Automatic installer and uninstaller 
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KeyNote on the Web
General Frenetics freeware - Homepage: 
http://www.lodz.pdi.net/~eristic/free/index.html
or http://come.to/generalfrenetics

Please see the above URL for links to download sites, up-to-date list of new features and known bugs. 
There's also a FAQ page which answers some of the frequently asked questions, as well as a list of 
planned additions to the program.

A special, separate project has been established for the purpose of open-source development of 
KeyNote. If you'd like to join the team, point your browser to http://keynote.sourceforge.net .

Erisian Warez: wicked Discordian tools:
http://come.to/fnord

Email to author:
eristic@lodz.pdi.net
or
cicho@polbox.com

Before emailing, please make sure you've read the FAQ on the website:
http://www.lodz.pdi.net/~eristic/free/keynote_faq.html

When you send me email, please always specify which version of the program you are using (as 
detailed 
as possible, e.g. KeyNote 1.01 A) as well as the operating system you are running it on. The OS
version is very important, because certain features do behave differently on Windows NT or WIndows 
2000.

Positively NO HTML-formatted email, please! HTML-encoded email 
will not be answered and may be bounced back to sender.

For an up-to-date information, please see the file "contact.html" distributed with the program. 
The file is located in the "\doc" subdirectory.

Note: Since my ISP's connectivity is rather slow, I am always looking for mirror sites. If you have a web or 
FTP server with 10 MB to spare, I would greatly appreciate your help. Thank you!



Tips and Tricks
· The "Recent files" command ("File" menu) contains names of several Note files that you opened or 

saved recently. Just click the menu item to open the file you want. 
· The list of recently used files is also available as a drop-down menu right next to the "Open" button on 

the toolbar.
· If users are sharing KeyNote on one computer, each user can have personal settings by specifying an 

alternate INI file name in the shortcut used to start KeyNote. Example: "c:\programs\keynote.exe c:\
users\jim\keynote.ini"

· Sometimes you may want to prevent others (or yourself!) from accidentally changing information in a 
note. You can give a specific note the "Read-only" attribute by choosing "Read Only" from the Tab 
menu, or pressing Shift+Ctrl+R.

· You can change the order of notes (tabs) in the file. Just click a tab with the mouse and drag it left or 
right. Alternatively, you can select the "Shift Tab" option in the Tab menu, and then click "Shift left" or 
"Shift right."

· You can also prevent all changes to a Notes file by clicking the "Open as Read-only" checkbox when 
opening the file.

· Some toolbar buttons and menu commands behave differently when Shift or Ctrl keys are held down. 
This is described in detail in the file "keyboard.txt".

· KeyNote supports macros and plugins. They are located on the Reource Panel (press F9 to show).
· Certain macros can run automatically whenever a new file or a new note is created. See "Auto-run 

macros" in file "macros.txt" for details.
· To access the Style drop-down list without the mouse, hold down Ctrl key and press the * key on the 

numeric keypad. Then select a style, and press Enter to apply it.
· Many dialog boxes in KeyNote are resizeable, and will remember their previous size and position when 

displayed.
· In File Properties dialog box, you can specify a custom system tray icon for the current file. This is 

useful if you run several instances of KeyNote at the same time.
· You can specify that the file should only use built-in tab icon images. This is useful when giving the file 

to someone who may be using a different, customized set of tab images.
· You can insert hyperlinks to jump to another place in your KeyNote file (a note or a tree node). See file 

"LINKING.TXT" for details.
· You can insert .BMP and .GIF images into the note text: select "Picture" from the "Insert" menu.
· You can create URL-style links to files on local disk: select "Link to file" from the "Insert" menu. Clicking 

the link will open the document or program.
· To specify all paragraph properties at one time, press Ctrl+P to open the Paragraph dialog box.
· To quickly insert often used chunks of text, use the Glossary feature. Add shortcuts and their full forms 

to glossary; then press F7 to expand a shortcut.
· Most editing and formatting commands can be repeated by pressing Ctrl+/. The name of the command 

to be repeated is shown in the context menu of the editor.
· KeyNote features simple bookmarks. Press Shift+Alt+digit to set a bookmark, then press Alt+digit to 

jump to it. (Digits are 0 through 9, naturally.)
· You can insert special characters into the note by pressing Shift+Ctrl+C.
· To quickly find a matching bracket, press Ctrl+M.
· You can export a single tree node. Right-click the node and select the "Export" command.
· KeyNote can play a sound while capturing text from clipboard. You can replace the default sound 

(clip.wav) with a .wav file of your choice.
· You can move or copy subtrees between tree notes and between files. See file "tree.txt" for details.
· You can copy a subtree from one note to another by clicking it and dropping on another tab.
· Tree notes can have a vertical layout (tree above the editor). This is configurable through Note 

Properties (F4).
· You can highlight text in a note. Press Ctrl+H, or hold down Shift and click the Color button on the 

toolbar.
· You can drag files from Windows Explorer onto KeyNote's window to open or import them.
· Several new font and paragraph properties have been added. See the new functions under the 



"Format" menu.
· The new "Virtual nodes" feature allows you to link an external text or RTF file to a node in a tree. Create

a new node, then right-click it and select the "Virtual node" command.
· To create a virtual node, you can also drag a text or RTF file from Windows Explorer onto the tree.
· To quickly rename a note, press F2 or double-click the tab where the note name is displayed.
· You can choose what happens when you click an URL in a note. See Options (F5), "Misc" tab.
· KeyNote can automatically minimize or close your file after a predefined period of inactivity. See 

Options (F5), "Actions" tab.
· Toolbars can also be docked at the bottom of the note window.
· This is BETA software. Handle with care. Please report bugs to the author. (See Help->About)
· Your KeyNote file can be securely encrypted. See file "Encrypt.txt" for details.
· You can create two types notes: simple or tree-type notes. Press Ctrl+N, and choose the type in the 

"Kind" drop-down box.
· You can quickly change the background color of ALL NODES in a tree: hold down the Shift key and 

click the "Background color" button on the toolbar.
· KeyNote can evaluate mathematical expressions. Type an expression (e.g. "2 + 2"), select it, then 

press Ctrl+=. The result will be copied to clipboard.
· You can set default note properties for the current file (rather than all files): In the "Note Defaults" dialog

box, click the "Special" button and click "Save as default for...".
· KeyNote has a simple file manager which allows you to quickly open a file you have used previously. 

Press F12 to open the file manager window.
· KeyNote is integrated with a dictionary/thesaurus program called WordWeb. Press Ctrl+F11 to look up 

current word in the thesaurus. See file "wordweb.txt" for details.
· You can import notes from another KeyNote file to the file which is currently open. Select Tools->Merge 

with File.
· If users are sharing KeyNote on one computer, each user can have personal settings by specifying an 

alternate INI file name in the shortcut used to start KeyNote.
· Keynote can automatically capture text copied to Clipboard in any Windows application: choose 

"Clipboard capture" from the "Note" menu.
· The program is highly configurable. Press F5 to open the Options dialog box and customize the 

settings.
· To create a new note, press Ctrl+N. To create a new KeyNote file, press Shift+Ctrl+N.
· To edit the properties of the selected note, press F4. To quickly rename a note, press F2.
· Click the right mouse button over different areas of the main window to display additional menu 

commands.
· If you have used a similar note program called DaRT Notes before, KeyNote can open and save files 

created by that program. See file "DART.TXT' for details.
· Please check the program's website for FAQ, a list of known issues, and upgrade information. See 

Help->About.
· When the program is minimized or hidden behind other windows, it can be brought to the front by 

pressing Shift+Ctrl+F12. (You can customize the hotkey.)
· Some RTF-related features may not work well on Windows NT or Windows 2000 systems that have 

version 3 of riched32.dll library installed.
· Keynote is and will remain free. If you enjoy using it, please consider making a small donation to an 

animal shelter in your area. Thank you!
· You can export notes from KeyNote and import plain text or RTF files into KeyNote. See Tools->Import 

and Tools->Export menu items.
· You can specify default attributes that will be assigned to each new note you create (such as font style, 

colors, icon, and others). See Tools->Defaults.
· Most editing functions have keyboard shortcuts assigned to them. You can look them up in the main 

menu.
· The file SAMPLE.KNT distributed with the program contains many additional hints and tips.
· You can move the toolbars by clicking and dragging them to a new location. Toolbars will remember the

new position. 
· If the note tabs take too much space and don't all fit on one line, you can shrink them by turning off their

icons. See Options (F5), "Chrome" tab.



· This program will always be distributed as Freeware. If you paid for it, you were cheated.
· It is the author's very strong opinion that advertising sponsored programs are NOT free. This program 

will never use such a scheme.
· You can send E-mail directly from Keynote: choose "Email note" from the "Note" menu.
· You can change the default icons displayed next to note names: See Options -> Icons tab.
· You can switch between notes by using your own hotkeys! Put the "&" character in front of a letter in a 

note name; then press ALT+letter to switch to that note.
· If the file attached to a virtual node has been modified by another application, right-click the node and 

select "Refresh" to update the contents of the node.
·



Other Freeware from General Frenetics, Discorp.

No ads, no nags! All applications from General Frenetics, Discorp. are 100% freeware. 
Some applications are distributed with full Delphi source code.

See http://www.lodz.pdi.net/~eristic/free/index.html

PhoneDeck
Flexible, configurable phone- and addressbook with phone dialer. 

Oubliette
Password manager with strong encryption. Includes source code.

KookieJar
Easily the best signature generator and randomizer for Windows!

InjectURL
Insert URL link into documents saved from the browser

VisitURL
Flexible, lightweight bookmark manager

GUIDClean
Strip the privacy-breaching Global Unique ID strings in MS Office documents (includes source code)

...And more!

These applications work with MS Windows 95/98/NT 4.0



Keyboard Reference
This topic contains a list of keyboard shortcuts used in KeyNote. Most shortcuts are visible and can easily
be discovered by inspecting the menu items; a few other key combinations are not visible in the program 
interface. All these shortcuts are listed here.

Some menu commands or toolbar buttons behave differently if the SHIFT or CTRL key is held down while
the command or button is clicked. See bottom of this file for a list of these special cases.

Note: as of version 1.5, keyboard shortcuts are configurable. The listing below shows the default key 
bindings (some may be omitted).

-----------------------------------------------------------
1. GENERAL SHORTCUTS
-----------------------------------------------------------

a) File-related commands:
Shift+Ctrl+N    Create a new KeyNote file
Ctrl+O          Open an existing KeyNote file
Ctrl+S          Save current KeyNote file
Ctrl+Q          Close currently open KeyNote file
F12             Open the File Manager window

Alt+Enter       Edit properties of currently open KeyNote file (Note: this 
command allows you to change the format of the file as well as specify whether
the file should be encrypted)

b) Note-related shortcuts:
Ctrl+N          Create a new Note
F2              Rename current Note (or change icon)
F3              Repeat last Find command ("Find next")
F4              Edit all properties of current note
Ctrl+F          Find text in note ("Find" dialog box)
Ctrl+F3         Replace text in note ("Replace" dialog box)
Shift+Ctrl+F    Find tree node by name (tree-type notes only)
F11             Use current note for clipboard capture
                (Does not work for Tree-type notes)

Shift+Ctrl+P    Print current Note
Shift+Ctrl+R    Set current note as Read-Only
Alt+Shift+Ctrl+E Send current Note via email

Tab             Switch focus from tree panel to editor
                Also: grey *
Shift+Tab       Switch focus from editor to tree panel
Ctrl+\          Toggle focus between editor and tree panel

Ctrl+Tab        Switch to the next note (tab)
                Also: Ctrl+PageDown
Shift+Ctrl+Tab  Switch to the previous note (tab)
                Also: Ctrl+PageUp



c) Other shortcuts:
F5              Edit program configuration options
F6              Edit default properties for new notes
F7              Expand term from Glossary definition
Shift+F7        Add new term to the Glossary
F8              Keep program window on top of all other application windows
F9              Show or hide the Resource Panel (alternative: double-click the
status bar)

ESCAPE          Depends on settings in Options dialog box, "Action" tab. 
(Minimize KeyNote, Exit KeyNote, do nothing). If the Find command is in 
progress, ESC key aborts the search. If the Replace command is in progress, 
ESC key aborts it. If the font name combo box or the font size box on the 
Format toolbar are focused, ESC key exits them and switches focus to the 
editor. If a macro is being recorded, stops recording the macro. If a macro is
being replayed, stops replaying the macro.

-----------------------------------------------------------
2. EDITOR SHORTCUTS (editor panel must be focused)
-----------------------------------------------------------

Ctrl+A          Select all text in the editor
Ctrl+B          Toggle BOLD font style
Ctrl+C          Copy selected text to clipboard
                Also: Ctrl+Insert
Ctrl+D          Select background color
Ctrl+E          Toggle BULLETS style for selected paragraph(s)
Ctrl+G          Go to specific line in the editor
Ctrl+H          Apply current highlight color to selected text
Ctrl+I          Toggle ITALIC font style
Ctrl+J          Join selected lines (reformat lines into a single paragraph)
Ctrl+K          Toggle STRIKEOUT font style
Ctrl+L          Toggle DISABLED font style
Ctrl+M          Jump to matching bracket
Ctrl+P          Select paragraph properties for selected paragraph(s)
Ctrl+R          Select font color for selected text
Ctrl+T          Select font properties for selected text
Ctrl+U          Toggle UNDERLINE font style
Ctrl+V          Paste text or image from clipboard
                Also: Shift+Insert
Ctrl+W          Toggle the Word-Wrap option
Ctrl+X          Cut selected text to clipboard
                Also: Shift+Delete
Ctrl+Y          Delete selected line

Ctrl+0          Clear font attributes for selected text
Ctrl+1          Select SINGLE line spacing for selected paragraph(s)
Ctrl+2          Select DOUBLE line spacing for selected paragraph(s)
Ctrl+5          Select ONE AND A HALF line spacing for selected paragraph(s)

Insert          Toggle INSERT / OVERWRITE mode for the editor

Ctrl+=          Evaluate expression
Alt+Insert      Paste result of last evaluated expression



Ctrl+-          Toggle SUPERSCRIPT font style
Shift+Ctrl+-    Toggle SUBSCRIPT font style

Ctrl+[          Shrink (decrease) font size for selected text
Ctrl+]          Grow (increase) font size for selected text

Ctrl+,          Increase space before paragraph
Ctrl+.          Increase space after paragraph
Shift+Ctrl+,    Decrease space before paragraph
Shift+Ctrl+.    Decrease space after paragraph

Ctrl+Alt+Left   Left-align selected text
Ctrl+Alt+Right  Right-align selected text
Ctrl+Alt+Up     Center selected text

Shift+Ctrl+C    Insert special character
Shift+Ctrl+D    Insert current date
Shift+Ctrl+E    Toggle NUMBERS style for selected paragraph(s)
Shift+Ctrl+H    Remove highlighting from selected text
Shift+Ctrl+I    Invert case of selected text (This -> tHIS)
Shift+Ctrl+L    Change selected text to lowercase
Shift+Ctrl+M    Change selected text to Mixed Case
Shift+Ctrl+S    Sort selected lines
Shift+Ctrl+T    Insert current time
Shift+Ctrl+U    Change selected text to UPPERCASE
Shift+Ctrl+Y    Insert hyperlink

Shift+Ctrl+0    Clear paragraph attributes
Shift+Ctrl+3    Apply Rot-13 to selected text
Shift+Ctrl+4    Reverse selected text

Shift+Ctrl+Ins  Paste as text (paste without any formatting)

Alt+Backspace   Undo (Multiple Undo is supported. Changes cannot be undone
                after the file has been saved)
Ctrl+Enter      Redo (i.e.: Undo the last "Undo" operation)
Ctrl+/          Repeat last command (the name of the command which will be 
repeated is displayed in the editor's context menu)

Shift+F4     Apply selected style to text (Style toolbar MUST be visible)

Ctrl+F8         Copy current font attributes
Shift+F8        Paste font attributes ("format paint")
Ctrl+F9         Copy current paragraph attributes
Shift+F9        Paste paragraph attributes ("format paint")

Ctrl+;          Increase first line indent
Shift+Ctrl+;    Decrease first line indent

Alt+;           Increase left indent
Shift+Alt+;     Decrease left indent

Ctrl+'          Increase RIGHT indent
Shift+Ctrl+'    Decrease RIGHT indent

Ctrl+Alt+W      Select current word in editor



Alt+Left        In a tree note, navigate BACKWARD in history
Alt+Right       In a tree note, navigate FORWEARD in history

Alt+Down        In a tree note, switch to NEXT node
Alt+Up          In a tree note, switch to PREVIOUS node
Shift+Alt+Left  In a tree note, move LEFT in the tree
Shift+Alt+Right In a tree note, move RIGHT in the tree

Ctrl+Grey * Switch focus to the Style combo box. (Select a style, then 
press Enter to apply it or ESC to cancel.) The Style toolbar must be visible.

Ctrl+Grey / Switch focus to the Macro combo box. (Select a macro, then 
press Enter to run it or ESC to cancel.) The Macro toolbar must be visible.

-----------------------------------------------------------
3. TREE SHORTCUTS (tree panel must be focused)
-----------------------------------------------------------

Enter           Add new node
Space           Rename selected node
Shift+Enter     Add new node as child of current node
Ctrl+Enter      Add new node immediately after current node
Insert          Insert new node before current
Delete          Delete selected node (optionally, delete all children too)
Shift+Delete    Delete all children of the selected node
Shift+Insert    Rename node by pasting text from clipboard

Shift+F11       Hide or show tree panel

Grey +          Expand all nodes in tree
Grey -          Collapse all nodes in tree
Grey *          Switch from tree panel to editor

Shift+Down      Move selected node down
Shift+Left      Move selected node left (promote in hierarchy)
Shift+Right     Move selected node right (demote in hierarchy)
Shift+Up        Move selected node up

Ctrl+B          Mark selected node Bold
Ctrl+C          Copy selected node's name to clipboard
Ctrl+D          Reset selected node colors (font and background) to default
Ctrl+E          Insert full path of selected node in editor
Ctrl+G          "Graft" (paste) a subtree previously lifted with Ctrl+Y
Ctrl+P          Copy selected node's path to clipboard
Ctrl+R          Refresh virtual node (reload file from disk)
Ctrl+T          Copy full text of selected node to clipboard
Ctrl+V          Make selected node virtual
Ctrl+X          Export selected node
Ctrl+Y          "Lift" a subtree (prepare subtree for pasting elswehere)

Shift+Ctrl+S    Sort entire tree
Shift+Ctrl+U    Sort selected subtree



Ctrl+`          Check/uncheck selected node

Alt+D           Rename node using current date
Alt+T           Rename node using current time
Shift+Alt+D     Rename node using current date and time

Alt+F11         Create a new tree node from text selected in current node

(Note: Another way of moving nodes is by dragging them and dropping in a new 
place. More tree commands are available from the tree context menu.)

-----------------------------------------------------------
4. OTHER
-----------------------------------------------------------

Alt+0 to Alt+9               Jump to bookmark number 0 through 9
                             (bookmark must be set)
Shift+Alt+0 to Shift+Alt+9   Set bookmark number 0 through 9

Shift+F5                     Execute selected macro (if Resource panel 
visible)
Ctrl+F5                      Run the most recently executed macro 

Shift+F6                     Insert internal KeyNote link
Ctrl+F6                      Mark location for internal KeyNote link

Shift+F12                    Run selected plugin (if Resource panel visible)
Ctrl+F12                     Run the most recently executed plugin

-----------------------------------------------------------
5. ALTERNATE shift OR ctrl COMMANDS
-----------------------------------------------------------

The following commands behave differently if the SHIFT, CTRL or ALT key is 
held down while the command is executed by pressing a toolbar button, clicking
a menu option, or performing other mouse action (drag and drop, double-click, 
etc.).

Save (File menu or toolbar button)
- with SHIFT, the Save As command is executed instead

Paste (Edit menu or toolbar button)
- with SHIFT, text is pasted as plain text
- with CTRL, the "Paste into new" command is executed instead.
- with ALT, the "Paste special" command is executed instead.

Paste into new (Edit menu)
- with SHIFT, text is pasted into a new note as plain text

Plugins (Tools menu)
- with SHIFT, KeyNote will re-initialize the list of installed plugins. This 
is useful if you have added or removed a plugin while KeyNote is running.

When double-clicking on the note tab:
- with SHIFT, the Note Properties dialog box is opened (normally, the simpler 
Rename note dialog box is opened)



When clicking an URL in the editor:
- depending on the setting in Options dialog box, "Misc" tab, pressing the 
SHIFT key may be required for the URL to be activated.
- with CTRL, the URL is opened in a new browser window, regardless of the "URL
action" option setting. (This only affects "http://" URLs.)

Background color (Format menu)
- with SHIFT, if current note is a tree-type note, the new background color 
will be applied to ALL NODES in the tree (normally, the command only affects 
the currently displayed node). After you select a color, a confirmation dialog
box is displayed. Shift key has no effect if the note is not a tree-type note.

Increase indent, Decrease indent (toolbar buttons)
- with SHIFT, the RIGHT indent gets increased or decreased, rather than the 
left indent.

WordWeb lookup (Insert menu, editor context menu, toolbar button)
- with SHIFT, you will be prompted to enter a word to look up in the WordWeb 
thesaurus. (Normally, KeyNote automatically picks the current word in the 
editor and looks it up.)

When dropping a tree node onto another node in the tree:
- with SHIFT, the Insert command is executed for the dragged node, meaning 
that the node will be inserted before the node onto which it was dropped. 
Normally, the dragged node is added as a child of the node onto which it was 
dropped.
- with CTRL, the dragged node is inserted as the FIRST node in the tree (it 
becomes the top, or root, node).

Copy node name (tree panel context menu)
- with SHIFT, the whole text of the current node is copied to clipboard, in 
addition to the name of the node. The text is copied without formatting.

Check/uncheck tree node, makde node bold or select node color:
- with SHIFT, the same command is also applied to all children of the selected
node
(i.e. all child nodes receive the same format or state as the current node).



Command Line Reference
When launching KeyNote from the command-line (Start->Run...) or from a 
shortcut, you can specify one or more command-line arguments. These arguments 
are equivalent to some configuration options and change certain aspects of the
program behavior.

usage: keynote.exe [filename[.knt]] [-option [-option...]]
Note: If a command-line argument is a file, just enter the full path and 
filename. Command-line arguments which are options must be preceded by a dash 
(-) or a slash (/), which is the usual convention for MS-DOS and MS Windows 
programs.

Command-line options may be typed in lowercase or UPPERCASE, and may be 
specified in any order.

Following is a list of command-line options KeyNote supports:

FILENAMES:
You can specify one or more filenames on the command-line to alter the default
behavior of the program. KeyNote relies on the file extension (file type) in 
interpreting the meaning of the option.

If you specify a... Keynote will...
.KNT file - open this file on startup
.INI file - use it as the configuration file instead of the 
default "keynote.ini") Note that this enables many users to
share KeyNote on one computer and

have their own, separate preferences.
.DEF file - read from this file default settings for newly 
created notes 

(instead of the default keynote.def)
.MGR file - use this file to fill the File Manager dialog box 
(instead of the

default keynote.mgr)

OPTIONS:
-min minimize on startup
The main program window will be automatically minimized when KeyNote is 
started. Note that you can achieve the same effect by opening the shortcut 
Properties window and specifying "Minimized" in the appropriate setting on the
Shortcut tab. If this option is not specified, KeyNote will restore the 
previous size and position of the main window.

-debug save some debug info
Turns ON debugging. This option iso only honored if the program was built with
debug code; otherwise it is ignored and has no effect on the program 
execution. When debugging is on, KeyNote periodically saves to disk a log file
containing some runtime information and any error messages that may have been 
issued.

-nso do not save options
If this option is specified, KeyNote will not save any configuration options 



you may change inside the program. You can still open the Options dialog box 
and change settings, but the changes you make will be lost after you close and
restart the program. This option may be useful when running KeyNote from a 
floppy disk.

-nro do not read options (IMPLIES 'nso')
If this option is specified, KeyNote will not read its configuration
file (keynote.ini). All options will be reset to factory defaults. If this 
option is specified, KeyNote ALSO assumed the -nso option (see above), so it 
will neither read nor save any changes in configuration.

NOTE: The simplest way to restore factory default configuration is to delete 
the file "keynote.ini" which resides in the directory where you installed 
KeyNote.

-reg register data file extension
If this option is specified, KeyNote will try to register its default document
extension (.knt) with itself. You can also perform this manually in Windows 
Explorer using the Options command in the View menu.

-nodef do not read or write default entry settings
If this option is specified, KeyNote will not load the default settings for 
new notes that you create (keynote.def) and will use factory defaults instead.
If you wish to restore factory default settings for newly created notes, just 
delete the file "keynote.def" which resides in the directory where you 
installed KeyNote.

-saveicn save factory default icons to bitmap file
For the programmer only; not useful for the users. Saves the default icon set 
to a bitmap file.

-noicn do NOT load user icons from external .ICN file
If this option is specified, KeyNote will not load the custom icons 
(keynote.icn) file at startup, and will use factory default icons instead. 
This option also disables the Icons tab in the Optioons dialog box, preventing
the user from changing icons.

-oldfmt use old (pre-0.85) file format. See relevant note in the file
"history.txt". This is only useful if you need to exchange your KeyNote file 
with someone who still uses a much older version of KeyNote. This setting is 
ignored if your current file contains tree-type notes, because the older 
versions of KeyNote will not be able to open such notes anyway.

-noreg do NOT store window size and position and the recently used
file list in the registry. Instead, this information is stored in a file with 
the ".mru" extension.



Information for Dart Notes Users
The concept of KeyNote is based on a similar tabbed notebook application I have been using for several 
years: DaRT Notes, by Andrew v.d. Merwe. The URL for DaRT Notes is 
http://users.iafrica.com/d/da/dart/DaRT/Software/Notes/Notes.html

DaRT Notes is an excellent and free program. I have gotten used to it so much that I never, literally never 
use pen and paper anymore. The author was very responsive to all comments, and for a long time the 
program grew in features and functionality.

However, the development of DaRT Notes ultimately stopped. I have finally decided to create a similar 
program, one that would have most of the original DaRT Notes features, and then some more. Hence 
KeyNote.

KeyNote is NOT a "clone" of DaRT Notes, though. It is similar, but not a one-to-one equivalent. It is a bit 
slower :) but more featureful, I hope.

IMPORTANT NOTE TO DART NOTES USERS: 
KeyNote can read and save files in the format used by DaRT Notes. Since KeyNote has some additional 
functionality, certain features or properties will not be preserved across sessions. For instance, DaRT 
Notes has no tab icons, so whatever icons you specify for the tabs in the file, will be lost after you save 
and reopen the file in the DaRT Notes format. However, if you would like to try out KeyNote without 
having to transfer all your notes, you can. If you open a DaRT Notes file, it will be automatically saved in 
that format, too. If you wish to change the format in which the file will be saved, open the File properties 
dialog box and in the "Format" list choose "Keynote native". Note that the file extension will be 
automatically changed depending on the format in which the file is being saved, so there is no danger of 
accidentally overwriting your DaRT Notes file.

If you are using a version of KeyNote later than 0.90, please note that KeyNote now supports two major 
features which Dart Notes doesn't have: encryption and tree-type notes. A file which uses these features 
(e.g. a file which contains at least one tree-type note) CANNOT be saved in Dart Notes format.

Many thanks to the author of DaRT Notes, Andre v.d. Merwe, for providing a very reliable and useful 
application, and for inspiration. Also, many thanks for documenting the file format used by DaRT Notes.



Known Problems and Bugs
KeyNote is updated very often - more often that this Help file. A detailed list of known problems and 
unfixed bugs is contained in the file called "Bugs.txt". The file is located in the "\doc" subdirectory, below 
the directory where KeyNote is installed.

You can also view the latest version of the Release History file on the Web:
http://www.lodz.pdi.net/~eristic/free/keynote_bugs.html

Information contained in this Help topic was current at the time when version 1.5 of KeyNote was 
released (June 2002).

--- BUGS and PROBLEMS ---
· PROBLEMS WITH PRINTING
Originally, there was a problem with printing from the richedit 
control via the page setup dialog: you'd always get two or three 
additional blank pages at the end of the prinout. I had no idea 
how to fix that and why it was happening.

There is now a "Safe print" option which you can turn on in the 
Options dialog, "Advanced" page. With "Safe print" OFF, the rich 
text is first filtered through the older version of the richedit 
control, which fixes the problem with surplus pages, but causes 
loss of certain formatting attributes which the older richedit 
version did not support (e.g. highlighting, paragraph spacing, 
the "disabled"-looking font style and a few others).

With SafePrint turned ON, the printing is done directly from the 
richedit control, so you get all the "advanced" formatting 
attributes, but the page setup dialog is simply bypassed, and all
settings you make there are ignored. For now, this is the best I 
can do.

· When working with files from network drives, you may receive 
the following message while saving the .KNT file: Folder 
monitoring has been disabled due to the following error: Win32 
error. Code: 2." The file, however, is saved correctly and no 
obvious error in fact occurs. If you encounter this problem, 
open the Options dialog box, click the "Advanced" tab, and 
CHECK the "Disable folder monitor" checkbox. The folder 
monitoring function is used to detect if another application 
has modified the file which is currently open in KeyNote (in 
such a case, KeyNote prompts you to reload the file from disk).
However, folder monitoring oly works with files on the local 
disk, not across a network. Disabling it will eliminate the 
faux error message, but KeyNote will no longer be able to 
detect file changes.



· When changing the default color of the tree nodes in "Note 
Properties" dialog box, the color change takes effect after the
file has been closed and reopened (or after KeyNote has been 
restarted). All other font properties take effect immediately. 
(This does not apply when setting a color for a specigic tree 
node uysing the tree panel's context menu.)

·
· When KeyNote is set to remain "always on top" ("View" menu), 
the font selection drop-down box becomes inaccessible 
(disabled) on some systems. I cannot reproduce this problem on 
Windows 95 or 2000, and I have really no idea why it happens.

·
· When a note uses a character set other than the system default,
it may not be possible to use the Find and Replace functions, 
because the text in the Find and Replace dialog boxes is not 
displayed correctly. Since specifying te character set for the 
dialog boxes does NOT solve the problem, I have currently no 
idea what to do about this.

·
· If you add (or possibly move) some nodes in the tree, and then 
change the tree layout (from horizonal to vertical, or the 
other way around), then the new nodes lose their original 
position. This does not affect the nodes that were created 
earlier. The problem does not occur if the file was saved and 
closed/reopened.

· Workaround: When you want to change the layout, save the file 
first *and reload it*. Just close the file and reopen it, or 
simply select the file from the "Recent files" menu. After you 
have reloaded the file, change the tree layout. This way, all 
nodes should stay where they were. You should probably save the
file at this point and reload it again, at least if you intend 
to make any further changes to the tree.

· On some systems you may receive an "Error code: 2" message 
while saving the .KNT file. (The message can also report: 
"Win32 Error. Code 2. The system cannot find the file 
specified".) The file, however, is saved correctly and no 
obvious error in fact occurs. If you encounter this problem, 
open the Options dialog box, click the "Advanced" tab, and 
CHECK the "Disable folder monitor" checkbox. The folder 
monitoring function is used to detect if another application 
has modified the file which is currently open in KeyNote (in 
such a case, KeyNote prompts you to reload the file from disk).
Apparently, the folder monitoring is incompatible with some 
versions or configurations of Windows, and it certainly does 
not work across a network. Disabling it will eliminate the faux



error message, but KeyNote will no longer be able to detect 
file changes.

· When using clipboard capture with some applications (such as 
Acrobat Reader), more than 1 copy of the text gets pasted in 
KeyNote. This was originally a problem with MS Word, which was 
fixed, but the issue remains with other applications. If you 
encounter this problem, please let me know which application 
you are copying text from. (In version 1.5 or later, try 
increasing the "SleepTime" value in keynote.ini, [ClipOptions] 
section.)

· In a tree node, if you change font color to black using the 
color button on the toolbar, then click another node and return
to the one in which you changed font color, the text that 
should be black will now be white (this only occurs under some 
specific conditions). I have no fix for this problem (KeyNote 
*does* set the color to black, of course!) The workaround is to
click the color button and use the "Default color" function, 
instead of "Black'. This solution is only valid if you have 
chosen black as default font color for the current note (in 
Note Properties dialog box, F4).

·
--- LIMITATIONS ---
· It is not possible to indent the first line of a paragraph; use TAB instead.
(The "First line indent" creates a hanging indent, which is the opposite to 
what many users expect.)

· ·
· Importing files: It is not possible to import files if no file is open, or 
if the current file does not contain any notes. Please make sure you have a 
file open and that the file contains at least one note before importing 
files.

· ·
· When a non-modal dialog box is open (Find or Replace), the Alt+Down arrow 
keyboard shortcut does not work in the drop-down list. Instead, the shortcut
is handled by KeyNote itself. This is _normal_, given how non-modal dialog 
boxes work in Windows, but it's still annoying. I hope to be able to work 
around this in version 2.0.

· ·
· In Favorites, it is not possible to specify command-line arguments for 
program shortcuts. However, command-line arguments may be added by manually 
editing the "keynote.fvr" file.

· ·
· Exporting notes in HTML format seems to do nothing: When exporting notes as 
HTML files, KeyNote uses a Microsoft HTML conversion library, "html32.cnv". 
If this file is not installed on your system, or not properly registered, 
the export procedure will fail without displaying any error messages. This 
will be fixed in version 2.0.

· ·
· When setting (or unsetting) the "Plain text" property of a tree-type note 
(in "Note Properties" dialog box), each node has to be manually edited (or 



at least clicked) before its contents will be updated according to the 
"Plain text" option setting. Nodes will display properly, but they will 
retain all text in the previously active format (RTF or plain text) until 
they have been clicked and selected for editing.

· ·
· When using the "Find all words" or "Find any word" search type on the 
resource panel, the "Search tree nodes" option is ignored, i.e. tree nodes 
are NOT searched. Tree nodes are only searched when you select the "Exact 
phrase" setting.

· ·
· Saving the notes file clears the Undo bufer; operations cannot be undone 
after the file was saved (manually or automatically). This is not done by 
design, but it's a "feature" of the RichEdit control. At this time, I have 
no idea how to work aroound it.

· ·
· Simple (non-tree) notes cannot be moved by drag-and-drop to tree notes, or 
"upgraded" to trees.

· ·
· The search and replace commands do not support metacharacters, so it's not 
possible to search for tabs or linebreaks.

· ·
· There is no way to activate a hyperlink using keyboard - only a mouse click 
will do. This issue is internal to the richedit library and I have no fix 
for this.

· ·
· There are MANY commands which cannot be used in macros. Usually, there is no
warning about it. Some information regarding this is included in the Help 
file ("Macros" topic). This is a design limitation; macros will be much more
robust in version 2.0, but have to stay the way they are in 1.x.

· ·
· When sending a note by email, the text of the note is not wrapped.
· ·
· When a non-modal dialog box is open (Find, Replace), you cannot use Alt+Up 
arrow and Alt+Down arrow key combinations in the dialog, if they are 
assigned to commands in KeyNote's main window. (By default, these key 
combinations are assigned to move one node up or down.) This is due to how 
non-modal dialog boxes work in Windows programs; the only workaround is to 
remove these key assignments using the "Customize keyboard" command.

· ·
· Icons are associated with notes by their index number. Therefore, if you 
delete an existing icon (Options dialog box, "Tab icons" section), icons 
following it will be shifted one slot backwards. This will change icons 
displayed with some notes. For instance, if you have 10 icons and you delete
icon number 3, the icons that were originally numbered 4-10 will now be 
numbered 3-9. Any note that displayed icon number 3 will now display the 
icon originally numbered 4, etc. Notes which used to display icon number 10 
will not display not icon (because there are only 9). If this is a problem, 
you should only add icons to the end of the list, and not delete any 
existing icons. (Note also that you can use a separate icon file for each 
KNT file you have, so a change in one set of icons need not affect other 
files.)

· ·
· When editing node icons, only one icon can be added at a time. (You cannot 
select more than one icon in the dialog box and add them all.)

· ·





End-User License Agreement (EULA)
KEYNOTE: MOZILLA PUBLIC LICENSE STATEMENT
Released: 30 June 2001
The contents of this package ("KeyNote") are subject to
the Mozilla Public License Version 1.1 (the "License");
you may not use this package except in compliance with 
the License. You may obtain a copy of the License at 
http://www.mozilla.org/MPL/

Software distributed under the License is distributed 
on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, 
either express or implied. See the License for the 
specific language governing rights and limitations 
under the License.

The Original Code is KeyNote 1.0.

The Initial Developer of the Original Code is Marek 
Jedlinski <eristic@lodz.pdi.net> (Poland). Portions 
created by Marek Jedlinski are Copyright (C) 2000, 
2001. All Rights Reserved.



Auxiliary Files
This topic describes the purpose of various files installed with KeyNote or created by the program.

Note KeyNote creates several auxiliary files as you use the program. These files will not be deleted by the
Setup program when you uninstall KeyNote. You will need to delete these files manually after uninstalling.

.KNT
KeyNote file
These are the files that contain you notes. File "sample.knt" is installed with KeyNote, but you should 
create your own. The sample.knt file will be overwritten when you upgrade KeyNote.

.KNE
Encrypted KeyNote file

.BAK
Backup file
Note that you can change the backup extension in the Options dialog box, so your backup files may be 
using a different extension.
These files may be safely deleted. They are created automatically by KeyNote each time your KNT/KNE 
file is saved, unless you turn OFF the Backup option.

.INI
Main KeyNote configuration file
This file may be safely deleted, but Keynote will recreate this file automatically. Note that some plugins 
may create INI files of their own, in the "plugins" subdirectory.

.MGR
File manager storage
This file contains a list of all KeyNote files you have used. Missing files are automatically removed. In 
KeyNote, you can press F12 to open the File Manager and quickly select one of the remembered files in 
order to open it.
This file may be safely deleted, but Keynote will recreate this file automatically.

.TIP
Tip of the Day file
This file contains a list of the "Tipof-the-Day's" which KeyNote displays at startup (optionally).
This file may be safely deleted.

.MRU
This file contains information about the most recently used files (hence the extension), as well as 
information about the size and position of several dialog boxes. When these dislog boxes are opened, 
their previous position and/or size are restored. Delete this file to reset the state of all dialog boxes to 
factory defaults.
This file may be safely deleted, but Keynote will recreate this file automatically.

.DEF
Default editor and tree settings for newly created notes. 
These are the options which you change with the "Default settings" command (under the "Tools" menu; or
press F6). Note that you can have separate default settings for each KNT/KNE file, hence more than 
one .DEF file.
This file may be safely deleted, but you will then have to select your preferred default settings again.

.ADR



Address book for sending notes via email
Each line in this file should contain one email address. When emailing a note, the contents of this file are 
loaded into the "To" and "Cc" drop-down boxes, so that you can easily select an email address. You can 
edit this file in a text editor.
This file may be safely deleted.

.SIG
Signature file for sending notes via email
This file is automatically appended to every email message sent from KeyNote. You can edit it in a text 
editor.
This file may be safely deleted.

.KNS
Style definition file.
All styles available in KeyNote are stored in this file.
This file may be safely deleted, but Keynote will recreate this file automatically whenever you create or 
edit styles.

.EXP
Glossary expansion file
This file may be safely deleted, but Keynote will recreate this file automatically whenever you add a term 
to the Glossary.

.KEY
Kayboard customization file
This file is created by the "funckey.knl" plugin which you can use to assign macros, plugins and styles to 
function key combinations. This file may be safely deleted.

.KNL
KeyNote plugin
A few plugins are installed with KeyNote; others may be downloaded from KeyNote website. It is also 
possible that you have downloaded and installed KeyNote plugins from third-party vendors. You should 
not delete plugins unless you definitely want to get rid of them :)

.KNM
KeyNote macro file
Each macro you create is saved to disk as a .KNM file. You can delete a .KNM file to remove an uneeded 
macro (this can also be achieved from inside KeyNote.)

.ICN
Tab icons storage
When you customize (add, remove) the icons which KeyNote displays on note tabs, your custom icons 
are saved in an .ICN file. Note that it is possible to have more than one .ICN file, because you can assign 
a different .ICN file to each KNT/KNE file.
If you delete this file, KeyNote will use its default, built-in tab icons.

.HLP
KeyNote Help file
This file does not yet exist :)

.WAV
Clipboard capture notification sound
KeyNote is distributed with a single wave file, "clip.wav". This file is optionally played whenver text is 
captured from clipboard. You can safely delete this file or replace it with another .WAV file to play a 
different sound. The file must be named "clip.wav".



.DAT
Uninstaller file
DO NOT DELETE this file, or you will not be able to uninstall KeyNote automatically.



Sharing KeyNote on a multi-user system
KeyNote files are not designed to be shared and updated concurrently by more than one user - 
attempting to do so will result in corrupting the file and data loss.

KeyNote can read and write files over a network. However, if the currently open file is updated by another 
user, Keynote will be able to detect this only if the file resides on local computer. KeyNote cannot detect 
external file modifications when the file is located on a network drive.

A single installation of KeyNote may, however, be shared by several users. Each user can create his or 
her configuration settings. To do so, each user must copy the main configuration file (keynote.ini) to a 
separate directory. Next, the user needs to create a shortcut to keynote.exe, and pass the full path to the 
custom location of the copied keynote.ini file (in the Shortcut Properties dialog box). This will cause 
KeyNote to read the custom ini file. Most other configuration files (e.g. keyboard customization, default 
formatting properties, etc.) will be automatically stored in the same directory in which the custom 
keynote.ini file resides.



Frequently Asked Questions
The FAQ included in this Help file is out of date. Please see KeyNote website for the latest version of 
the FAQ file: http://www.lodz.pdi.net/~eristic/free/keynote_faq.html

Frequently asked questions    

Q: Does KeyNote have a spell checker? 
A: No, and it's unlikely to get one. There are commercial spellchecking components available, but they 
are costly, while KeyNote is free. I don't have the time to start writing my own - let alone compile a 
dictionary! At the moment I'm investigating several freeware options, and there's a chance that one of 
them will be suitable; but I can't promise any particular implementation yet. Also - remember that KeyNote
is designed as a program for taking little (or not so little) personal notes; adding a full spellchecking 
capability sounds like overkill. I'm only looking into this because it's the number one request I've been 
receiving :-) 
Update 1: No spellcheck yet, but KeyNote now features integration with WordWeb 
(http://wordweb.co.uk/free), a freeware dictionary and thesaurus. Please see the file "wordweb.txt" 
(installed with KeyNote) for details. 
Update 2: As of version 0.999, a spellchecker could be implemented as a plugin module. If you are a 
software developer and would like to try your hand at it, please download the plugin development kit to 
see how plugins work in KeyNote. 
 
Q: Can I print only 1 page (or a few selected pages) instead of printing the whole note? 
A: Unfortunately, you can't, because the standard RichEdit control does not support this. It's easy to 
notice that the editor doesn't have a notion of page breaks - hence, no page selection for printing. It is 
possible to implement such a feature, but it would really take more effort than it's worth. Instead, you may:

Select the part of the text you want to print; copy it to clipboard, then choose the "Paste Into New" 
command from the "Edit" menu. This will create a new, default note and paste the selected text into it 
automatically. Then print that new note and delete it afterwards. 
Export the note from which you wish to print to an .RTF file, and load the file into Word or any other RTF-
enabled editor which does support selecting pages, and print from there. 

 
Q: Every time I start KeyNote, the "Register KeyNote file type" screen comes up. 
A: What happens is that Keynote tries to create a file type association for .KNT files, but fails. 
When you start the program again, KeyNote sees the file extension still isn't properly associated so it tries
again... and again. I don't uderstand why it fails on some systems; I'm using a very standard way of 
associating a file type with an application. Anyway, for now, you can just turn the whole feature off: it's in 
the Options dialog, "Main" tab: the "Auto register file type" and "Prompt before registering" checkboxes. 
You can turn off prompting, so Keynote will still be trying to make the association, but will not display the 
confirmation dialog. Or you can turn the "Auto register" option too and, if you like, create the association 
manually via Windows Explorer.
 
Q: Can I encrypt the Notes file? 
A: Yes! Starting with version 0.90, KeyNote supports secure encryption of the notes file. Before 
you start using encryption, you absolutely must read the file called "encrypt.txt" included with KeyNote (in 
the "\doc" subdirectory). Remember that if you forget the passphrase you used to encrypt the file, you will 
not be able to access the text in the file - that, after all, is the whole point of encryption. 
 
Q: Every time I change the font style, size or color to my preferences, all the changes are gone 
when I close the file and open it again later. 
A: This is not so much a bug, as a gross incompatibility that Microsoft introduced with version 3.0 of the
RichEdit control (riched2.dll). Most Windows NT systems, many Windows 98 systems and all Windows 



ME and Windows 2000 systems will experience this problem. The differences are such that some 
behaviors of the editor become difficult to predict. To make matters worse, I have no access to Windows 
NT or 2000 systems, so I can't test and debug this issue personally. 
Update: As of version 0.89 of KeyNote, most of these incompatibilities are worked around. Font styles 
and colors are now correctly retained. A few minor problems remain, and they will be eliminated in a later 
release. Thanks muchly to Marek "Anglik" Cieslik for fearless debugging! 

You may also observe this problem when changing certain properties of the note tabs, such as tab 
location (top or bottom). Please see file "bugs.txt" for details. (This file is installed in KeyNote's "\dic" 
subdirectory.) 

One other possible solution: Microsoft prohibits software authors from distributing the riched2.dll file (and 
for a good reason, because each system has its own version) - but if you can find a Windows machine 
with a compatible riched2.dll version 2.0 (not 3.0), you can just copy it to KEYNOTE's DIRECTORY (not 
to the system directory) and KeyNote will use it instead. Despite MS's ban, you should be able to find 
copies riched2.dll on the internet, but because different versions have the same file name, it may be hard 
to figure out if any particular copy is ight for your system. but if you managed that, the whole problem 
would immediately go away (and other apps would still be using the 3.0 version if they need it). 
 
Q: Can I create links to local documents on my computer? 
A: Yes! It's already possible (from version 0.91 upwards). This only works with tree-type notes. Create a 
new node in a tree, then right-click it, and choose "Virtual node" from the context menu. This "links" an 
external file to that node - the file will remain on disk, and you will be editing the original file, not a copy. 
The file contents are not imported into the .KNT file (only the filename is stored). This makes KeyNote 
behave just like any old text editor, of course :) You can link only text and RTF files this way. (The 
keynote.ini file has a setting to define which file extensions are to be interpreted as text files). Note that if 
the file is a text file (not RTF), then you still can modify the font styles in KeyNote, but they will be lost 
when the file is saved back to disk. RTF files will retain all text formatting made in KeyNote. Also note that
in this way you cannot attach files on removable media (a network drive, a diskette, a CD-ROM drive) and
that if you move your KeyNote file to another computer, the virtual nodes may become "orphaned" if the 
files they were linked to no longer exist. 

 
Q: Will KeyNote ever support bookmarks?
A: Not really. I've added a very basic bookmark support (version 0.974 upwards). But these bookmarks 
are dumb - they only mark an absolute location in the editor ("the 520th character from the start"), not a 
part of the actual text. If you add or remove text BEFORE a bookmark, the bookmark will stay in place 
and won't point to the original text anymore. There is absolutely no practical way this could be done any 
better - because to have real bookmarks, KeyNote would have to recalculate the positions of all 
bookmarks each time you press a key (add a letter, press the Delete key, paste or cut text, etc). This is 
possible in theory, but in practice it would result in horribly complex and SLOW code. 

Also, the RTF editor doesn't have the concept of a gutter, so there's no space in which to display the 
bookmarks - they're invisible. 

As a matter of comparison, MS Word solves the problem neatly - by inserting a character into the text at 
the bookmark position. However, (a) Word's bookmarks aren't automatically numbered (you have to give 
them a name, which makes the whole thing too time-consuming to use fequently), and (b) the bookmark 
pointer is inserted in the space BETWEEN normal characters - Word can do this, but the standard richedit
control cannot. Basically, to recreate Word's functionality, you can just add strings such as "{1}", "{2}", etc. 
into the text, and then use the Find function to search for these. It won't be any worse than what I could 
do with a specialized dialog box. 
 
Q: Will you add support for hyperlinks to notes or tree nodes? 
A: Done. As of version 0.985 beta, KeyNote supports hyperlinks which jump to another note or tree node.
Please read the file "linking.txt" installed with the program to find out how to use this feature. The old 



answer to this FAQ is retained, below, because it contains some background information which is still 
relevant. 

This could be useful: clicking a hyperlink would take you to a location in another note, or another node in 
a tree. It's possible, but there's one catch. As defined by Internet standards, URLs cannot contain spaces.
When they do, spaces have to be encoded as octal numbers (%20 for space; other codes are used too). 
The richedit control does not (and should not) support spaces in URLs, either. 

This becomes a problem when you have a note with a space in the name - how do you link to a note 
that's called "Black and white"?
          link://thisfile/black and white
is NOT going to work - the editor breaks the hyperlink at the first space. (Try it with any "http://" URL.) 

It does work if you encode the spaces properly:
          link://thisfile/black%20and%20white and this is how such hyperlinks have been implemented in 
KeyNote. 
 
Q: Can I export notes to an HTML file? 
A: No, not with a true RTF-to-HTML conversion. This is on the To-Do list, but it's hard to do well. 
Conversion between plain text and HTML is easy, but true RTF conversion isn't. Commercial converters 
exist, but are rather expensive to purchase. Of the two freeware converters I have found, one produces 
absolutely hideous HTML which in no way reflects the original RTF formatting; the other is much better, 
but still buggy. If I can fix the problems with it, I'll incorporate it into KeyNote - but it's not going to happen 
very soon. 
 
Q: Does KeyNote support templates for creating new notes? 
A: Yes. This is already possible, it just isn't called templates! Create a new .KNT file where you will keep 
the template notes. Then, while you work in another file and want to create a note based on one of your 
templates, use the "Merge" function under the "Tools" menu. Click the "Merge notes from file" command, 
select the file which contains your templates, and then select the template to use. 

The only thing missing from this scenario is the ability to export a note as a template. There is a rather 
silly limitation in the way I designed KeyNote that prevents me from implementing such a feature. It will be
done eventually, but you can already use templates. 
 
Q: Why can't I use the "&" character as part of the note name? 
A: You can, but there's a catch. When you place a single "&" character in the name of a note, it is used 
for a special "fast switching" function. The character is not displayed - instead, the letter immediately 
following it becomes underlined (as in any Windows menu). You can then press Alt+<the underlined 
letter> to open that note without having to click it or to press Ctrl+TAB several times. For instance, if you 
name a note "&Black", the letter B will be underlined ("Black") and you can switch to this note by pressing 
Alt+B. 

If you need to use the "&" character in the name of a note, enter it twice:
          "Black && white"
The name will now be shown the way you intended. 
 
Q: Why is the executable file so large? 
A: Mumble. There are three answers to this. One: It's not my fault! Two: Oh well, I could do better. Three:
Everyone else is cheating (well, they often are). 

It's not my fault. Every serious application written using Borlands Visual Component Library - be it a 
Delphi or a C++ program - is going to be about a megabyte in size, or more. This is part of the price paid 
for the convenience and reliability that the VCL affords a programmer. It would be possible not to use this 
library and write a complete program using only Windows API calls. Such a program would be extremely 
tight and lean, but coding this way would take years (literally) and would be immensely difficult. There are 



still programming wizards who work this way, and they certainly deserve a lot of respect. I'm just not one 
of them. 

I could do better. What can I say, I'm learning things as I go, and often I may not be choosing the optimal
way of doing things. When I do optimize, I choose to optimize for speed rather than the size of the 
program. Note also that even if the size of the executable is, e.g., 1.5 MB, this does not mean that the 
whole 1.5 megabyte is loaded into your computer's memory at all times. Much of that size is consumed by
various resources the program contains, such as icon images, dialog box definitions, etc. These are only 
loaded when they are necessary, and then discarded. Windows reads resources from the executable 
program as it needs them - that, by the way, is one reason you cannot delete a running application: 
Windows locks it, because it may be need to read information from it while the program is running. 

Everyone else is cheating! Not everyone, exactly, but many software authors do. If you have a program 
of a complexity similar to KeyNote and you see that it takes only 400-500 kilobytes on disk, there's a good
chance the executable has been compressed to appear smaller. You can view the binary code of a 
program to verify it - if it contains incomplete or "broken" looking strings, it was probably compressed. If 
the header contains a name such as "aspack" (one of several popular exe-packers for Windows), it was 
certainly compressed. This is sometimes done to prevent people from easily decompiling or cracking an 
application, but note that when you run the program, the file is decompressed to memory, so it has 
disadvantages too: the program takes longer to start, and consumes even more memory than it otherwise
would (the decompression code). Also, such compressed executables are wasteful of resources: since 
Windows cannot read a compressed file, the program resources cannot be loaded dynamically or shared 
among several instances of the same application. 

Please see also the next two answers.
 
Q: Why are KeyNote data files so large? Could KeyNote compress them on the fly? 
A: No. First of all, compressing files on the fly would make KeyNote much slower. Try zipping a 30 MB file
with WinZip or any other compression program - that takes several seconds even on fast computers. 
KeyNote would have to do the same every time it saves (or opens) a file. This sort of delay is out of the 
question in a "quick notes" type of application. 

But more importantly: file size as such isn't really a problem. Disk space is relatively cheap today; hard 
disk sizes begin at 20 GB. The problem is memory and system resources - especially on Windows 95 and
98 systems, which still are limited in this respect. A zipped file would be small on disk, but it would have to
be unpacked for editing, and would still take a huge amount of RAM and resources. 

Normally, KeyNote files are not large. They will only grow to huge sizes if you insert pictures or objects in 
them. I added this ability because many users requested it; but KeyNote (or any RTF editor) is not a 
suitable program for this task. Rich Text Format files have their own way of storing graphics as 
uncompressed bitmaps converted to text (view the source of an RTF file to see what I mean). This is 
inefficient, slow, and results in huge file sizes. Even HTML is much better suited for this, because you can 
use GIF and JPEG files, which are internally compressed. With RTF, no matter what format of an image 
file you insert, it is automatically converted into an uncompressed bitmap. Note that the situation is 
identical when you insert images in a Word or a WordPad document. 

Finally, I designed the file format for KeyNote on purpose - it's a plain text file (with embedded chunks of 
RTF code). In case of any problem, you can open the file in a text editor and edit it. For instance, if 
someone uses an earlier version of KeyNote which didn't support trees, it would be quite easy to modify a
.KNT file manually so that it can be opened in the older version of KeyNote. This is of course helpful not 
only in emergencies, but also it allows other programmers to import and export files in KeyNote format 
easily (the way KeyNote can read and write Treepad files). If the file is compressed, this becomes 
impossible, or at least very difficult to do, and in case of any problem, you could not modify the file. 
 
Q: Can KeyNote be run from a floppy disk? 
A: Yes, but. Currently (version 0.985) KeyNote just about fits on a 1.44 MB diskette. Do not install 



KeyNote onto a floppy disk, but install it to your hard drive and then just copy "keynote.exe" to the floppy. 
You do not need to copy any of the supplementary files (*.tip, *.wav, *.adr, *.sig, *.kns); KeyNote will work 
fine without them, but they are small so you might as well include them if you want. KeyNote will create its
own configuration files, though, so make sure some space is left on the floppy. Also, as KeyNote grows in 
size, there may be little or no room for the actual data file(s). 

If KeyNote and its associated files do not fit on a diskette, you can use an "executable compressor" 
program (like the ones I berate in the answer above ;) to compress KeyNote's executable file. I 
recommend that you use the UPX (Universal Packer for Executables) program 
(http://wildsau.idv.uni-linz.ac.at/mfx/upx.html). It is freeware, it is Open Source, and it 
yields a really impressive compression ratio: it compresses KeyNote.exe from 1.37 MB to 476 kilobytes! 
Please see UPX homepage for download links. UPX is a command-line application, but there are GUI 
front-ends available (such as WinUPX). 

 
Q: Why can't I create numbered lists or tables in KeyNote? (They can be pasted from Word, but 
cannot be created inside KeyNote) 
A: The standard richedit control (which displays and "drives" and rich text editor) does not 
support tables. It doesn't support many other formatting elements which MS Word has, e.g. numbered 
lists, footnotes, tables of content, even simples things like page numbers and page formatting. Word is 
*not* based on the standard richedit control, it's a completely separate implementation. 

If you have one of the latest versions of Windows installed (or perhaps MS Office 2000), then you will 
have the very latest version of the richedit control installed on your system (version 3.0 of the file 
"riched20.dll"). You can read more about it in the FAQ and in the "bugs.txt" file distributed with KeyNote. 

Version 3.0 of the richedit control introduced support for a few new formatting elements: numbered lists 
and, indeed, tables. That's why you can paste a table from Word. (I *cannot*, on my system, because I 
run Windows 95 and I have an older version of the richedit control.) You should also be able to paste a 
numbered list. However, you cannot create them inside KeyNote, because the improved richedit control 
(3.0) is not supported by Borland Delphi, which I used to create KeyNote. Simply put, Delphi does not 
know about the added capabilities. 

I don't even know, at this point, if Borland have added this to the latest version of Delphi (6.0) which was 
released around June 2001. If they have, then a later version of KeyNote could allow you to create tables,
but first I would have to purchase the latest Borland Delphi, which I can not currently afford. 

I have now released version 1.0 of KeyNote, and, as promised, I have also released full source code 
under Mozilla Public License. Any programmer can now download KeyNote source and improve it, so 
perhaps someone else will do all that, eventually. 
 
Q: Will KeyNote ever be able to display alarms, reminders or to-do lists? 
A: Maybe. I realize that it would be an extremely useful addition: a new kind of note which would store 
and display a list of to-do items, alarms, periodic reminders, etc. I am seriously considering something like
this for version 2.0 of KeyNote. However, this type of functionality raises a terribly difficult design problem,
if the alarms were to be stored inside KeyNote files. 

When you use a reminder program, you expect to rely on it; once you enter an alarm or a to-do item, you 
expect that the program will display an appropriate alarm or show a message when necessary. The 
program must not fail to do so. 

But if you had your reminders stored in a .KNT file, they would only be active as long as that 
particular .KNT file was opened in KeyNote. The moment you opened a different .KNT file, the reminders 
would not be working anymore, which makes the whole function useless. 

Perhaps most users typically work with a single file only; but KeyNote was designed to allow you to create



many .KNT files and quickly switch from one to another. For the purpose of displaying reminders, alarms, 
etc., this is completely unsuitable. For instance, I use over 10 separate .KNT files for different kinds of 
information, so if my reminders were kept in one of these files, they would almost never be actually 
displayed. KeyNote doesn't seem to be the right kind of program for this type of functionality. 

Now, reminders could be stored in a separate file, not in the .KNT file where you have all your notes. That
separate "reminder file" would always stay open, regardless of what .KNT file you are working with. But 
this solution also has its problems. For instance, if you wanted to make a backup, you would have to 
remember to back up two files, instead of just one. And if several people shared KeyNote on one 
computer, they would have to share the "reminder file" as well, because there would only be one! This, 
again, is not a satisfactory solution. 

If I ever figure out how to implement such functionality correctly, I will include it in version 2.0 of KeyNote. 
If you have an idea, please let me know! 
 



KeyNote files
Keynote is not a "normal" editor for text or rich text format files. KeyNote is based around the 
concept of having many notes stored in a single file on disk. This means that you can organize 
information in a more orderly way, and make sit easier to kep related information in one place, instead of 
having it scattered over many files in different places. A KeyNote file is a collection of notes in RTF format.
One Keynote file may include the contents of many single text or rtf files.

Such a concept requires using a special file format. KeyNote creates its own files with the .KNT extension
(or .KNE, for encrypted files). A KNT file stores all notes, with their formatted text and configuration 
settings (such as the name of the note, the icon associated with it, background color, etc.). While you can 
view KNT files with a text editor, such as Notepad, you will not be able to edit them easily. You will 
certainly not be able to open KNT files using an RTF editor (such as WordPad). Files with the .KNE 
extension are binary, encrypted files, and can only be opened by KeyNote.

What all this means is that KeyNote cannot be used as a replacement for NotePad or WordPad. 
KeyNote is not designed that way; it is not meant as a simple editor for text or RTF files. KeyNote cannot 
open such files directly. (If you try that, KeyNote will display an error message: "Invalid file 
header. This is not a Keynote file".

Text (.txt) or rich text (.rtf) files can be imported into KeyNote files, via the Tools|Import command. 
Imported files will become notes in the currently open .KNT file; the original files will be left on disk, 
untouched. (You can also import files by dragging them from Windows Explorer and dropping them on 
KeyNote's toolbar or statusbar area.)

Another way of editing text or rich text format files in KeyNote is by using the so-called "Virtual nodes". 
This allows you to use KeyNote as if it were a simple editor for text and rtf files: you will be edting the 
actual files on disk, without importing them into the .KNT file. The easiest way to create a virtual node is to
drag a file from Windows Explorer and drop it onto the tree panel in a tree-type note.



KeyNote editor



Tree-type notes
GENERAL INFORMATION

As of version 0.90, KeyNote now supports a new kind of notes: a "tree-type" note. These notes 
come in addition to the original notes, which are still available.

The tree notes are more efficient, they load faster when you open the file, and allow you to organize 
information better. You can freely mix the old-style "plain" editor notes and tree notes within one file.

There is no limit to the number of "nodes" (i.e. separate notes, or "branches") in the tree. There is also no 
limit to the length of text that each note, or each tree "branch" can contain.

If you have used previous versions of KeyNote, please note that files wich contain tree-type notes cannot 
be opened in older versions of KeyNote. This is important if you want to exchange .KNT files with another 
KeyNote user. Ask them to upgrade! :)

CREATING TREE-TYPE NOTES

To create a tree-type note, do what you normally do to add a new note to the file: press Ctrl+N, or choose 
"New note" from the "Note" menu. In the "New Note" dialog box, click the "Type" drop-down list, and 
select "Multi-level tree". (Selecting "Simple Rich Text Editor" will create an old-style note without the tree.)

If you like, you can also click the "Properties" button to open a dialog box where you can specify many 
options for the note you are creating. (For instance, you can specify the font and background color for the 
tree text.) After you have finished configuring the properties, click OK to close the Properties dialog box.

Click OK to close the "New Note" dialog box and create the new note.

A new note will be created. The note will contain a tree with one node. You can add nodes to the tree, edit
them and drag in the tree. (See below for information about tree functions and keyboard shortcuts.)

To switch from the editor to the tree, or from the tree back to the editor, press Ctrl+\ or press the "*" 
(asterisk) on the numeric keypad.

Once you have created a plain or a tree-type note, you cannot change its type. You can, however, edit all 
properties of the note at any time by pressing F4.

TREE FUNCTIONS

· You can add an unlimited number of branches to the tree
· There is no limit to how deep you can nest tree branches.
· You can drag and drop branches in the tree.
· You can sort the whole tree or a selected branch
· You can specify all font properties for the tree text (F4)
· You can change the background color of the tree (F4)
· You can move nodes Up, Down, Left or Right (Shift+<arrow>)
· You can rename nodes, or paste a node name from clipboard
· You can show or hide the branch icons in the tree
· You can save the tree structure to a file
· You can export the contents of a single node in the tree.
· The tree panel can be arrranged horizontally (to the left of the editor) or vertically (on top of the editor)
· You can drag a tree node and drop it in a new location. You can also drag a node onto another note, to 



move the node there
· You can select a custom icon for each tree node
· You can select a custom font color and background color for each tree node
· Each node can be individually exported to a text, RTF or HTML file

See also: Virtual nodes

All these functions are accessible via the right-click context menu in the tree, or via the "Tree" main menu.
Most functions have keyboard shortcuts assigned to them.

COPYING OR MOVING BETWEEN NOTES

You can now copy or move antire subtrees from noe tree note to another, or even from one file to another.
Start by right-clicking the tree and selecting "Transfer", and then "Copy Subtree" from the context menu. 
Next, move to the tree where you want to add the copied nodes. You can also open another KeyNote file 
(the nodes you have copied are retained in memory).

In the target tree, click the node below which you wish to add the copied subtree, and in the tree context 
menu select "Transfer", and then "Paste Subtree Here".

Note that the target tree must already have at least one node; otherwise you will not be able to paste 
nodes into it.

You can achieve the same result by clicking a subtree and dragging it to another tab - but of course this 
will only allow you to transfer nodes within a file.

To move nodes rather then copying them, you need to manually delete the original subtree after you have
copied it.

CONFIGURING TREE SETTINGS

Some tree-related options can be specified separatey for each tree. To do this, press F4 (or choose 
"Properties" from the "Note" menu), then click the "Tree settings" tab. On this tab you can specify, for 
instance, the font and color properties for the tree, as well as the default name that will be used when 
creating new branches.

Many other tree-related settings are global, that is, they apply to ALL notes that contain trees, in all files. 
To edit these global settings, press F6 (or choose the "Default settings for Notes" command under the 
"Tools" menu), then click the "General settings" tab. There are many configuration options which enable to
you tailor the behavior of the tree (and the editor) to your preferences.

KEYBOARD SHORTCUTS FOR TREE-RELATED COMMANDS:

To add a node to the tree:
press Enter

To insert a node above current node:
press Ins

To add a child to selected node:
press Shift+Enter

To rename selected node:
press Space or Shift+F2

To delete selected node:
press Del

To delete all children of selected node:



press Shift+Del
To move selected node:

pressShift+<direction arrow>
(e.g. Shift+Down arrow to move node down)

To switch focus from Note editor to tree:
press Ctrl+\ or Shift+Tab

To switch focus from Note tree to editor:
press Ctrl+\ or TAB

Click here for a complete list of keyboard shortcuts

TREE LIMITATIONS and DIFFERENCES BETWEEN TREE-TYPE AND PLAIN NOTES

Editing and editor settings:
Each node ("branch") in the tree has its own formatted text and its own background color. All other 

editor settings are global FOR THE GIVEN NOTE. For instance, if you turn on the Word-Wrap function, all
nodes in the tree will be word-wrapped. You cannot turn the word-wrap feature ON for some nodes, and 
OFF for other nodes. This shouldn't be a problem: in fact, since trees can contain even hundreds of 
nodes, it would be very confusing if each node had independent editor settings.

Export and Email functions:
When exporting a tree-type note as plain text, contents of the whole tree are saved to a single text 

file. When exporting a tree-type note as RTF (Rich Text Format) file, each node is saved to a 
separate .RTF document. These documents are named automatically, using the names of the original tree
nodes.

When sending a tree-type note as email, you can only send it as plain text. Unlike plain, old-style 
notes, you cannot send a tree-type note as a single RTF attachment.

In general, it is impossible to create a single RTF file which contains text from all nodes in a tree. It is 
only possible to create a plain text (*.TXT) file that way.

Clipboard capture:
Tree-type notes CANNOT be used for clipboard capture. You must create a plain note for this 

purpose.

UNDO feature of the editor:
After making some editing changes in node A, and then clicking another node (B) in the tree, you will 

not be able to Undo the changes in node A. This limitation is imposed by the editor itself, and a 
workaround is unlikely.

DRAG-AND-DROP OPERATIONS IN TREE

Each node in the tree can be dragged and dropped in a new position.

Dragging a node onto another node adds it as a child of this node,

If you hold down the SHIFT key while dropping a node, the node is inserted on the SAME LEVEL as the 
node onto which you have dropped it (rather than becoming a child node).

If you hold down the CTRL key while dropping a node onto a top-level (root) node, the node wil be placed 
as the FIRST TOP NODE in the tree.



Dragging a node or a subtree to another tab copies it to that tab (provided that the tab holds a tree-type 
note, of course)

If you drag a text or an RTF file from Windows Explorer onto the tree, the file will be added to the tree as 
a Virtual Node.

MISCELLANEOUS NOTES

You can turn off the tree node icons for each tree independently. The icons cannot be changed and there 
will be no such possibility.

All nodes can contain text. There is no concept of a "folder" node as separate from an actual note. There 
is also no concept of a "root node", i.e. you can have as many 0-level nodes as you want. I think this 
approach is better than having separate "folder" and "note" branches, because a folder is merely an 
empty branch in the tree. KeyNote can put text in ANY branch, so each node in the tree can be a note 
AND a folder at the same time.

As you know from the previous versions of KeyNote, the program can remember the position of the caret 
in each note, and restore it when you open the file. The same is now true for trees: KeyNote can 
optionally remember which node in the tree was selected, and automatically jump to this node when you 
open the file later on.

You can make the tree wider or narrower by dragging the vertical "splitter" bar which divides the tree from 
the editor. Each note retains the tree width independently of other notes, and the width of the tree is 
always restored when you open a previously saved file. (If the size of the main KeyNote window is too 
small to make the tree as wide as it was previously, the tree is automatically narrowed to fit.)

Nodes in the tree can be moved with the keyboard. Hold down SHIFT while you click the arrows keys. 
You can move nodes UP/DOWN (within the list of siblings) or LEFT/RIGHT (Left: promotes the node 1 
level Up; Right: demotes the node 1 level down.) By combining these moves, a node can be relocated to 
ANY possible position in the tree.

New nodes that you add to the tree can be named automatically. In the Note Properties dialog box, click 
the [?] button to see what is possible. For instance, when you create a new node in the tree, this node's 
number can be added to the name.



Virtual nodes

Virtual nodes are nodes in the tree which behave in a    special way. A virtual node does not contain its 
own text in KeyNote, like normal nodes do. Instead, a virtual node is linked to a file on your disk. The 
text of that file is displayed in KeyNote and may be edited in exactly the same way as any normal note. 
However, when KeyNote saves the file, the text in the virtual node is saved back to the original file on 
disk, rather than being saved in the KeyNote file itself.

This allows you to keep certain files separate and be edit them in other applications (such as NotePad or 
WordPad), and at the same time to edit these files inside KeyNote.

Note, however, that if you copy the KeyNote file to a diskette or move it to another computer, the virtual 
nodes may become "orphaned", because their linked files will remain in their original location on your 
hard disk.

You can only link text (*.txt) or Rich text (*.rtf) files to a virtual node. If the file on disk is a plain text file, 
any formatting styles that you apply to this file's virtual node will be lost, because the file will be saved in 
its original, plain text format.

TIP: If a file you want to link as a virtual node does not have the ".txt" extension, but it really is a plain text 
file, you can add that extension to the list of file extensions that KeyNote recognizes. Click here for more 
information.

To create a virtual node: Add a normal node to the tree the way you always do. Do not type anything in 
the node's editor window. Right-click the node with your mouse, and from the context menu select the 
"Virtual node" command. A standard "File open" dialog box will be displayed, allowing you to choose the 
file on disk which you want to link to the node. Select the file and click OK.

Important: If you encrypt a file containing virtual nodes, the text in the disk files will not be encrypted. Click
here for more information.

Additional notes:
· A virtual node can be reverted to a "normal" node. If you click the "Virtual node" command in the tree 

context menu on a node that already is virtual, you will be given an option to revert the node to normal. 
The contents of the linked file will be retained, but the link with the file will be broken, and the text will 
now be stored in the .KNT file. This enables you to import RTF and text files directly into tree nodes, 
although in a somewhat roundabout way.

· You can also create virtual nodes by dragging files from Windows Explorer and drpoping them on the 
tree panel in KeyNote.

See also: Importing files



Configuring KeyNote - Overview - Overview
KeyNote is highly configurable. While I realize that the sheer number of configuration options may 
intimidate some users, it gives the program a valuable flexibility. 

There are three main groups of configuration settings in KeyNote: OPTIONS, FILE PROPERTIES, and 
NOTE PROPERTIES.

I. CONFIGURATION OPTIONS are global settings for the whole program. For example, they allow you to 
choose whether KeyNote should automatically save your files, whether backup files should be created, 
what should happen when you press the Escape key, etc. You can also specify here several global 
options pertaining to the editor and tree panels. To change these configuration options, press F5 or select 
"Configuration options" from the "Tools" menu.

Click here to learn more about specfying Configuration options

II. FILE PROPERTIES is a small group of settings related to the whole .KNT file, rather than particular 
notes inside it. For example, you can specify the format in which the file should be saved, choose whether
the file should be encrypted (and specify the access passphrase requireed to open the file), add a 
description which will make it easier to identify the file, etc.

To change FILE PROPERTIES for the currently open file, press Alt+Enter, or select the "Properties" 
command from the "File" menu.

Click here to learn more about specfying File properties

III. NOTE PROPERTIES are settings that apply to particular notes, so that each note within a single file 
can have its own, separate set of properties. These are, for example, the name of the note and the icon 
displayed next to the name, the background color of the editor, the "Word Wrap" option, or the layout of a 
tree-type note (whether the tree should be shown to the left of the editor, or above it).

These note-specific properties can be set in two different ways: you can change the properties for each 
individual note, but you can also set DEFAULT PROPERTIES for all the new notes that you will later 
create. For example, you can specify that each new note should have white background by default - but 
you can also change the background color of any individual note to yellow.

a) To change properties for an INDIVIDUAL NOTE, press F4, or select the "Note properties" command 
from the "Note" menu. Alternatively, you can also right-click the note and select the "Note properties" 
command from the context menu. Changes will only affect the note which is currently active.

b) To change DEFAULT PROPERTIES for all NEWLY CREATED NOTES, press F6, or select the "Default
settings" command from the Tools menu. Changes will only affect notes tat you will later create; existing 
notes will NOT be affected.

Note that properties for the active note and default properties for new notes are edited in the same exact 
dialog box - because these are the same properties. The title bar of the dialog box indicates whether you 
are editing active note properties, or defaults for notes that you will later create.

Click here to learn more about specfying Note properties and defaults

TIP: Often you will only want to rename the active note or change its icon. You can do this via the Note 
properties dialog box, but it is faster to just press F2 or double-click the note's tab (above the editor, 
where the note name and icon are shown). This is equivalent to selecting the "Rename note" command 
from the "Notes" menu.





Configuration options
CONFIGURATION OPTIONS are global settings for the whole program. For example, they allow you to 
choose whether KeyNote should automatically save your files, whether backup files should be created, 
what should happen when you press the Escape key, etc. You can also specify here several global 
options pertaining to the editor and tree panels. To change these configuration options, press F5 or select 
"Configuration options" from the "Tools" menu.

The Options dialog box contains a tree panel to the left, and several tabs to the right. Each tab contains a 
group of related configuration settings. To navigate from one tab to another, click one of the nodes in the 
tree panel.

TIP: To quickly switch back to the tree panel, press Shift+ESC.

Click the links below for details about settings available on each tab.

General settings
Rich Text editor
Tree panel
KeyNote files
File options
Actions
Confirmations
Chrome
Tab icons
Advanced
Formats
Clipboard capture
File types



Options: General settings

Minimize to system tray
If enabled, KeyNote will place its icon in the system tray area (next to the clock in the right hand corner of 
the screen) when minimized.
If disabled, KeyNote will minimize itself to the normal button on the taskbar.
Note: When KeyNote is minimized, you can quickly bring it up by clicking the system tray icon, or by 
pressing the Activation Hotkey combination (Shift+Ctrl+F12 by default)
Default: YES

Start program minimized
If enabled, KeyNote will automatically minimize itself on startup.
If disabled, KeyNote will start up in a normal window.
Note: You can also force KeyNote to minimize at startup by adding the "-min" switch to the commandline 
in the shortcut you use to launch KeyNote.
Default: NO

Do not close; minimize instead
If enabled, KeyNote will minimize itself, instead of exiting, when you click the right-most [x] button in the 
top-right corner of the window.
If disabled, clicking the [x] will cause KeyNote to exit (this is the standard behavior)
Note: If this box is enabled, you can still exit KeyNote normally by clicking the "File|Exit" menu option, or 
right-clicking the icon in the system tray and selecting the "Exit" command.
Default: NO

Show splash screen
If enabled, the splash screen will be briefly displayed while KeyNote is starting up. Note that this only 
minimally slows down the startup process; there is absolutely no artificial delay, and the splash screen is 
immediately hidden when KeyNote is ready to display the file.
If disabled, the splash screen will not be shown. You can still view the information by selecting the "About"
command from the "Help" menu.
Default: YES

Show tooltip hints
If enabled, brief information messages will be shown whenever you move the mouse cursor over various 
elements of KeyNote interface.
If disabled, the tooltips will not be shown. However, the same information is still displayed in the Status 
bar (even if another dialog box is opened)
Default: YES

On Escape key
Choose what should happen when you press the ESCAPE key. Available options are: Do nothing, 
MInimize KeyNote, Exit Keynote.
Default: Minimize KeyNote

Activation Hotkey
Click this box and press Backspace to delete the existing hotkey. Next, press the new hotkey which you 
want to use to bring KeyNote to front when it is minimized or hidden begind other application windows.
Note: The hotkey you specify here is system-wide. This means that no other application will be able to 
use this key combination (it is overridden by KeyNote).
Note also, that if you run multiple instances of KeyNote, only the first instance will be able to use this 
hotkey.
If you do not want to use any hotkey, leave this field blank.
Default: Shift+Ctrl+F12



Warn when cannot assign activation hotkey
If enabled, KeyNote will display a warning message when it cannot assign the hotkey. Hotkey assignment
may fail if anorther application was started before KeyNote and it uses the same hotkey. Note that the 
warning will not be shown when you start more than one instance of KeyNote, because obviously only the
first instance will be able to register the hotkey for itself
If disabled, KeyNote will never show the warning about having failed to register the hotkey.



Options: Rich Text Editor

Automaticaly select whole words
Show caret position in status bar
Save and restore caret position
Auto indent lines
Undo buffer limit:
Increment indents by:
Increment font size by:
Increment para space by:



Options: Tree panel

After creating a new node, switch to edit mode
Edit nodes "in place" (no dialog box)
Auto-name virtual nodes
Save and restore last active node in tree
Inherit BG color from active node
Hot track tree nodes
Show tree initially expanded
Auto scroll tree on mouse movement
Show tooltips in tree



Options: KeyNote Files

Load last-used file
If enabled, KeyNote will automatically open on startup the file that was open when you last used KeyNote.
If disabled, KeyNote will not try to automatically open the last-used file.
Note: If both "Load last-used file" and "Load specific file" boxes are disabled, KeyNote will not try to open 
any file at startup, and will create a new blank file instead. You can still open files automatically by double-
clicking a KeyNote file (a file with the .KNT extension) in Windows Explorer.
Default: YES

Load specific file:
If enabled, KeyNote will always try to open, at startup, the file specified in the file name edit box below.
If disabled, KeyNote will not try to open the specified file automatically.
Note: If both "Load last-used file" and "Load specific file" boxes are disabled, KeyNote will not try to open 
any file at startup, and will create a new blank file instead. You can still open files automatically by double-
clicking a KeyNote file (a file with the .KNT extension) in Windows Explorer.
Default: NO

Automatically save changes in KeyNote file
If enabled, KeyNote will automatically save your file when necessary, if the file has been modified.
If disabled, KeyNote will never save the file automatically. If the file has been modified, KeyNote will 
display a prompt, asking you whether the file should be saved. You will be able to asnwer "Yes" (save the 
file), "No" (do not save the file, lose all changes) or "Cancel" (do not perform the operation that required 
saving the file).
Note: If the box is enabled, the file is automatically saved when you close the file, create a new file or 
open an existing file. See the "On focus change" and "Every ... minutes" checkboxes for additional 
settings related to the AutoSave function.
Default: YES

When you switch to another application
If enabled, and if the AutoSave setting is ON, KeyNote will automatically save the file (if it has been 
modified) when you switch to another application. This is the recommended setting, because it ensures 
that your file is saved frequently, and saving the file does not delay your work - because it happens when 
you stop using KeyNote and go to another application.
If disabled, the file will not be automatically saved when you switch from KeyNote to another application.
Note: This checkbox is unavailable if the "Automatically save changes" box is disabled.
Default: YES

Every [n] minutes
If enabled, and if the AutoSave setting is ON, KeyNote will automatically save the file (if it has been 
modified) at the timer interval that you can specify, in minutes, using the numeric edit field.
If disabled, KeyNote will not automatically save the file at timer intervals.
Note: This checkbox is unavailable if the "Automatically save changes" box is disabled.
Default: NO

TIP: If the "Automatically save changes in KeyNote file" option is enabled, but both "When you switch to 
another application" and "Every [n] minutes" are disabled, your KeyNote file will be saved automatically 
only when absolutely necessary: when you exit KeyNote, open or create another file, or whenever you 
invoke a command that would cause a loss of data if the file was not saved first.



Options: File Options

Remember recently used files
If enabled, KeyNote will remember several of the last-used files, and will display the list of them in the 
"Recent Files" menu (Under the "File" menu). Click one of these files to open it. This provides fast access 
to recently used files, because you do not need to search for the file using the Open File dialog box. 
Specify the number of recent files that KeyNote should remember by entering a value in the numeric edit 
box.
If disabled, KeyNote will not display the "Recent Files" menu.
Note: The list of recently used files can be accessed even faster by clicking the down arrow next to the 
"Open" button on the main toolbar.
Default: YES

Display as Submenu
If enabled, the list of recently used files will be displayed as a submenu under the "File" menu.
If disabled, the list of recently used files will be displayed directly below the "File" menu (somewhat 
quicker to click, but clutters the menu).
Note: This checkbox is unavailable if the "Remember recently used files" box is disabled.
Default: YES

Show Full path in MRU menu
If enabled, the menu of recently used files will display full filenames (with paths)
If disabled, the menu of recently used files will display shortened filenames (names only; no paths)
Note: This checkbox is unavailable if the "Remember recently used files" box is disabled.
Default: YES

Open in Read-Only mode:
Enable this option for "Files on floppy disks" and / or "Files on network drives" if you want KeyNote to 
automatically open such files for viewing only.

NOTE: In some other cases, files will be opened as Read-Only automatically. For instance, files that 
already have the Read-Only attribute set, or files located on CD-ROM discs will always be opened in this 
mode. 

Files opened in Read-Only mode can be edited, but you will have to save them with a different name 
(using the "Save As..." command under the "File" menu) or close them without saving the changes at all.

Warn when opening file in    Read-Only mode
If enabled, KeyNote will display a warning message after having opened a file in Read-Only mode.
If disabled, KeyNote will not display a warning message. 

TIP: If a file was opened in Read-Only mode, KeyNote displays a special icon (with a bright red "X") in the
status bar.

Auto register file type (associate .KNT files with KeyNote)
If enabled, KeyNote will try to register its file type (.KNT) in Windows, so that you will be able to open 
KeyNote files just by double-clicking them in the WIndows Explorer.
If disabled, KeyNote will not try to register its file type at startup. You can still regiuster the .KNT file 
extention manually (Choose "View|Options|File types" in Windows Explorer.)
Note: The registration check delays program startup slightly.
Default: NO

Prompt before creating file association
If enabled, KeyNote will prompt for confirmation before registering its file type (.KNT)



If disabled, KeyNote will automatically register its file type without prompting for confirmation.,
Note: This setting is unavailable if "Auto register file type" box is disabled.
Default: YES

Use alternate extension (.KNE) for encrypted files
If enabled, KeyNote will automatically save encrypted files with a different extension (KNE).
If disabled, KeyNote will use the same extension (KNT) for encrypted and non-encrypted files.
Default: NO



Options: Backup
Backup original file when saving changes
If enabled, KeyNote will create a backup of your file when saving.
If disabled, no backup files will be made.
Default: YES

Do not replace extension; append instead
If enabled, the backup extension (.BAK, by default) will be appended to the name of the original file (e.g. 
"myfile.knt.bak")
If disabled, the backup extension will replace the original file extension (e.g. "myfile.bak")
Default: YES

Backup file extension:
This edit box allows you to change the extension that will be used for creating backup files.
Note: Several standard KeyNote extensions are reserved and cannot be used for the backup files. For 
instance, ".KNT", ".KNE" and ".n_text" cannot be used as extensions for backup files.
Default: .BAK



Options: Actions

Minimize KeyNote after 
Close Notes file after
Auto-close encrypted files only
On URL click:
Shift key must be held down when URL is clicked
Minimize KeyNote on URL launch
Launch "file://" URLs without prompting



Options: Confirmations

Confirm before closing KeyNote
If enabled, KeyNote will prompt for confirmation before exiting.
If disabled, KeyNote will always exit without prompting.
Note: KeyNote never prompts for exit confirmation if it detects that Windows is being shut down.
Default: NO

Confirm before deleting a note
If enabled, KeyNote will prompt for confirmation before removing a tab with its note.
If disabled, KeyNote will not prompt for confirmation before removing a note.
Note: Removing a note cannot be undone. 
Default: YES

Confirm before deleting tree node
If enabled, KeyNote will prompt for confirmation before removing a node from a tree.
If disabled, KeyNote will not prompt for confirmation before removing a node.
Note: Removing a tree node cannot be undone.
Default: YES

Confirm before pasting tree nodes
If enabled, KeyNote will prompt for confirmation when you drag and drop tree nodes onto another note, or
when you use the "Paste nodes" command.
If disabled, KeyNote will drag and drop and paste tree nodes without asking for confirmation.
Default: YES

Automatically paste expression evaluation results
If enabled, the result of the "Evaluate expression" command will be immediately inserted into the note 
text. (The result is also copied to clipboard.)
If disabled, the result of the "Evaluate expression" command will not be inserted into the note text. (The 
result is copied to clipboard.)
Note: In both cases, KeyNote remembers the result of the last expression evaluation performed. You can 
paste the result at any time by pressing Alt+Insert.
Default: YES

Automatically insert text from plugins
If enabled, KeyNote will prompt for confirmation before inserting text generated by a plugin.
If disabled, KeyNote will insert such text automatically, after the plugin has shut down.



Options: Chrome

Settings for: (x) Active tab ( )Inactive tabs
Click the radio button which corresponds to the mode for which you want to change the color. Only one 
tab can be active at any given moment - this is the tab which holds the note you are currently editong (the
"active note"). All other tabs are considered "inactive". You can have different colors for active and 
inactive tabs, but they will both use the same font.

Font button
Select the font style to use for displaying note names on tabs

Color button
Select the color for active or inactive note tabs

Reset button
Restore default value for tab fonts and colors

Sample font
This edit field displays what the tabs will look like with currently selected font and color values

Show icons on tabs
If enabled, icons will be displayed on note tabs.
If disabled, no icons will be displayed on tabs.
Note: Alternatively, you can turn icons On or OFF separately for each file: close this dialog box and 
choose "Properties" from the "File" menu.
Default: YES

Hot track in tabs
If enabled, the tabs will become highlighted when you move mouse cursor over them
If disabled, the tabs will not respond to mouse movements, only to clicks

Tabs are on top
If enabled, note tabs will be displayed on top, i.e. above the editor
If disabled, note tabs will be displayed at the bottom, i.e. below the editor

Multiline tabs (arrange in rows when cannot fit)
If enabled, note tabs will be arrenged in multiple rows if the don't fit in current width of the editor panel
If disabled, scroll arrows (left-right) will be displayed in the upper right corner of the editor panel if the tabs
do not fit



Options: Tab icons
This page allows you to customize the icons used for the note tabs. You can add, insert or delete icons.

Add... button
Opens a standard Windows file selection dialog box, and adds the icon you select to the end of the list

Insert... button
Opens a standard Windows file selection dialog box, and inserts the icon you select at the current position
in list.
Warning: Inserting an icon will move all subsequent icons forward. As a result, existing notes will now 
display different icons.

Delete button
Deletes the selected icon from list.
Warning: Deleting an icon will move all subsequent icons backward. As a result, existing notes will now 
display different icons.

Reset button
Reloads the built-in set of icons, effectively removing any customization.



Options: Advanced

Disable folder monitor
A change in this setting will take effect after you close and restart KeyNote.

Show font samples in Font combo box
A change in this setting will take effect after you close and restart KeyNote.

Longer drop-down lists on toolbars
A change in this setting will take effect after you close and restart KeyNote.

Enable Rich Edit version 3.0 fixes
A change in this setting will take effect after you close and restart KeyNote or re-open the current file.

Old style color selection dialogs

Allow Auto-run macros

Safe print mode

Allow only one instance
If enabled, you will only be able to start KeyNote once. If you start KeyNote while it is already running, the
already-running instance will be activated instead.
If disabled, you will be able to run many instances of KeyNote side by side.
Note: If you run several instances of KeyNote, remember that you should not be editing the same file in 
more than one instance. KeyNote has some built-in protection against this, but it may still be unhealthy.
Default: YES

Fix scroll bars in tree-type notes

Do not save window settings to registry



Options: Formats

Date format
Enter the format for the Date text to be used for the "Insert date" command. The format is the same as the
one used in Control Panel, Regional Settings, Long Date Format.
Note: You can freely experiment with this format. A sample result is displayed below the edit box.
Default: The default date format defined on your system.

Time format
Enter the format for the Time text to be used for the "Insert time" command. The format is the same as the
one used in Control Panel, Regional Settings, Time Format.
Note: You can freely experiment with this format. A sample result is displayed below the edit box.
Default: The default time format defined on your system.

Default to current text font
Close dialog box on insert



Options: Clipboard capture

Divider string placed before captured text:
Ignore when Keynote is active
Paste as plain text
Limit size of captured text to:
Play sound on capture (clip.wav)
Remember Capture note across program sessions



Options: File types

Text file extensions 
Add...
Delete
Reset



Options: Language



KeyNote File properties
FILE PROPERTIES is a small group of settings related to the whole .KNT file, rather than particular notes
inside it. For example, you can specify the format in which the file should be saved, choose whether the 
file should be encrypted (and specify the access passphrase requireed to open the file), add a description
which will make it easier to identify the file, etc.

To change FILE PROPERTIES for the currently open file, press Alt+Enter, or select the "Properties" 
command from the "File" menu.

The dialog box contains four tab sheets (of which only three are visible if your KeyNote file is not 
encrypted). Click the links below for details about settings available on each tab.

Information tab
Settings tab
File icons tab
Security tab



File properties: Information
On this tab you can view or change general information about the current KeyNote file.

Filename: Displays the full name of the currently open file. This information is for display only. To change 
the name of the file, close the File properties dialog box, then select the "Save As..." command from the 
"File" menu, and save the file with a new name.

Description: This is a short description text that will make it easier for you to identify the file. This text is 
displayed in the File manager dialog box.

Comment: Just like the Description field, the Comment field provides additional space for describing the 
file.    This text is also displayed in the File manager dialog box.

NOTE: When you encrypt the file, both the Description and the Comment fields are not encrypted, and 
are still displayed in the File manager dialog box.

Format: This drop-down list allows you to choose the format in which the KeyNote file should be saved:
· KeyNote native: 
default, basic format
· KeyNote encrypted: 
choose this format if you want to encrypt the file, and then click the Security tab.
· Dart Notes: 
this format is provided for compatibility with the Dart Notes program. Choose this format if you want to 
save the file in a format which can be read by the Dart Notes program. Note that if your file contains tree-
type notes, it cannot be saved in Dart Notes format.

Below, more information is displayed about the currently open file, including the date the file was created, 
the size of the file and the number of notes which the file contains.

System button: Click this button to open the standard Windows "File properties" dialog box. This is the 
same dialog box that is displayed when you right-click a file in Windows Explorer and select the 
"Properties" command from the menu.



File properties: Settings
On this tab you can view or change settings for the current KeyNote file.

Open this file in Read-Only Mode: If this option is enabled, the next time you open the file in KeyNote, 
the file will be opened as Read-Only. You will still be able to modify the file, but you will not be able to 
save it. In order to save the file, you will have to use the "Save As..." command under the "Tools" menu.



File properties: File icons
On this tab you can view or change icons used for current KeyNote file.

Show icon images on tabs: If this option is enabled, icons will be displayed on the tabs next to the name
of each note. If this option is disabled, icons will not be displayed on tabs. Use this command to 
permanently enable or disable tab icons for the current file. 

TIP: To quickly show or hide tab icons while working with KeyNote, press F9 or select the "Show icons on 
tabs" command from the "View" menu. This command will be disabled (inactive) if the "Show icon images 
on tabs" option on the "File icons" tab is disabled.

Default: Default icons will be used. This means that the file will use the same set of tab icons as all other 
files. You can customize these icons in Options dialog box, "Tab icons" page.
Built-in: Only the built-in icons will be used for this file. You cannot customize the built-in set of icons. If 
you share your file with others, this setting allows you to make sure that everyone will see the same icons,
even if they have customized the default tab icons.
Other: Allows you to select a specific .ICN (icon storage) file, which contains the set of custom icons you 
want to use for this KeyNote file. If you choose this option, you will have to specify the name of the 
custom .ICN file in the edit field below.

Use custom tray icon for this file: This setting allows you to specify that KeyNote should display a 
custom icon in the system tray area when the current KeyNote file is open. This allows you to quickly 
identify which file is currently open in KeyNote, just by looking at the tray icon. If you choose this option, 
you will have to specify the name of the custom icon (.ICO file) in the edit field below.



File properties: Security
On this tab you can specify security settings for the current KeyNote file.

Note: The "Security" tab is only visible if you have selected "KeyNote encrypted" in the "Format" drop-
down list on the "Information" tab.

Initially, a KeyNote file is not encrypted. When you select the "KeyNote encrypted" option as the format in 
which the file should be saved. the "Security" tab becomes visible, so that you can specify the access 
passphrase which will be used to encrypt and decrypt the file.

Each time you specify the access passphrase, you must type it twice: in the "Passphrase" and in the 
"Confirm pass." fields.

In the "Algorithm" field you can select the cryptographic method used to encrypt the file.

Once your file has been encrypted, you can change the passphrase at any time. To do so, click the "Set 
passphrase" button, and enter the passphrase as described above.

If you no longer want to have the file encrypted, click the "Information" tab and choose a different 
(unencrypted) file format. The default format is "KeyNote native".

Important: Click here to learn more about encrypting KeyNote files.



Note properties and defaults
NOTE PROPERTIES are settings that apply to particular notes, so that each note within a single file can 
have its own, separate set of properties. These are, for example, the name of the note and the icon 
displayed next to the name, the background color of the editor, the "Word Wrap" option, or the layout of a 
tree-type note (whether the tree should be shown to the left of the editor, or above it).

These note-specific properties can be set in two different ways: you can change the properties for each 
individual note, but you can also set DEFAULT PROPERTIES for all the new notes that you will later 
create. For example, you can specify that each new note should have white background by default - but 
you can also change the background color of any individual note to yellow.

a) To change properties for an INDIVIDUAL NOTE, press F4, or select the "Note properties" 
command from the "Note" menu. Alternatively, you can also right-click the note and select the "Note 
properties" command from the context menu. Changes will only affect the note which is currently active.

b) To change DEFAULT PROPERTIES for all NEWLY CREATED NOTES, press F6, or select the 
"Default settings" command from the "Tools" menu. Changes will only affect notes tat you will later 
create; existing notes will NOT be affected.

Note that properties for the active note and default properties for new notes are edited in the same exact 
dialog box - because these are the same properties. The title bar of the dialog box indicates whether you 
are editing active note properties, or defaults for notes that you will later create.

The dialog box contains between one and three tab sheets (depending on the type of note and on 
whether you are editing active note properties or default properties for new notes). Click the links below 
for details about settings available on each tab.

Note settings tab
Tree settings tab
Advanced tab



Note properties: Note settings
On this tab sheet you can specify note- and editor-related settings for:
1. Active note, if you have opened the dialog box by pressing F4 or using the "Note properties" 
command, or
2. All notes that you will later create in this or any other KeyNote file, if you have opened this dialog box
by pressing F6 or using the "Default settings" command.

Note name
for active note: enter a new name to rename the active note
as default: enter name that will be used as default for newly created notes

Note icon
for active note: choose the icon that you want to be shown on the tab, next to the note name
as default: choose icon that will be preselected as default for newly created notes

Detect and highlight URLs in editor
for active note: specifies whether hyperlinks (URls) should be highllighted and "clickable" in the editor. 
Note a change in this setting will take effect after you have reopened the current file.
as default: preselects the option for all newly created notes.

Wrap long lines
for active note: toggles wrapping lines that are too long to fit in the width of the editor panel. This is 
equivalent to selecting the "Word wrap" command in the "Format" menu.
as default: preselects the option for all newly created notes.

Use Tab character
for active note: specifies whether KeyNote inserts a Tab character or a number of spaces when you press
the TAB key. If you disable this option, KeyNote will insert the number of spaces specified in the "Tab 
size" field.
as default: preselects the option for all newly created notes.

Tab size
for active note: If the "Use Tab character" option is disabled, specifies the number of spaces KeyNote will 
insert when you press the TAB key. The default value is 4 spaces.
as default: preselects the option for all newly created notes.

Font button
for active note: selects initial font style for active note. Does not affect already existing text!
as default: selects initial font style for all newly created notes.

BG Color button
for active note: changes the background color for the active note.
as default: selects initial background color for all newly created notes.

Reset button
for active note: resets initial font style and background color for the active note. Does not affect already 
existing text!
as default: resets initial font style and background color for all newly created notes.

See also: Information about default and initial font styles for notes



Note properties: Tree settings
On this tab sheet you can specify tree-related settings for:
1. Active note, if you have opened the dialog box by pressing F4 or using the "Note properties" 
command, and if the active note is a tree-type note, or
2. All tree-type notes that you will later create in this or any other KeyNote file, if you have opened this 
dialog box by pressing F6 or using the "Default settings" command.

When editing properties for an active note which is a "simple editor" note, this tab sheet will not be visible.

Default name for new tree nodes
for active note: specifies the default name for all new tree nodes you will add to the tree in active note
as default: specifies default name for all new tree nodes you will add to trees in all newly created notes

TIP: The string can contain special "tokens" which KeyNote will automatically replace with values. This 
allows you to partly automate the naming of nodes. For instance, current date or time can be 
automatically added as part of the node name when creating the node. Click the [?] button to display a 
dialog box listing available tokens and their meanings.

Add sequential number to names of new nodes
for active note: if enabled, whenever yu add a new node to the tree in active note, the number of the node
will be appended to its name. For instance, if the tree already has 5 nodes, the next node you create will 
be automatically named "New node 6" (assuming that you specified "New node" in the "Default name for 
new tree nodes" field, above.)
as default: preselects the option for trees in all newly created notes.

Show node-level icons in tree
for active note: displays or hides node icons in the active note tree
as default: preselects the option for trees in all newly created notes.

TIP: You can quickly show or hide tree icons by selecting the "Show icons in tree" command from the 
"View" menu.

Vertical layout
for active note: specifies the layout for active note. If the option is enabled, the tree will be shown above 
the editor. If the option is disabled, the tree will be shown to the left of the editor (horizontal layout). By 
default, this option is disabled.
as default: preselects the option for all newly created tree-type notes.

Font button
for active note: selects font style for the tree in active note
as default: selects initial font style for trees in all newly created tree-type notes

BG Color button
for active note: selects background color for the tree in active note
as default: selects background color for trees in all newly created tree-type notes

Reset button
for active note: resets font style and background color for the tree in the active note.
as default: resets font style and background color for trees in all newly created notes.



Note properties: Advanced
This tab sheet is only visible if you have opened the dialog box by pressing F6 or selecting the "Default 
settings" command under the "Tools" menu.

When editing DEFAULT SETTINGS    for new notes, you can choose to apply these settings not to all 
notes that you will later create (the normal behavior), but to all notes that you will add TO THE 
CURRENT FILE ONLY. That way you can have different default settings for each individual file. Example:
you may normally want all new notes to have white background by default, but for one special file you 
may want to have new notes created with black background instead. To save note properties as defaults 
for current file only, click the "Advanced" tab, and make sure the "Save as default for <filename>" option is
selected.



About initial fonts and colors in KeyNote
Initial note font versus actual font styles in a note.

The Note properties dialog box (F4) cannot be used to change the FONT of the current note. The reason 
for this is quite simple. In a plain-text editor you have only one font (name, size, style, color) for the whole 
text. But KeyNote is a "rich text" editor, where you may have lots of different font styles within a single 
piece of text. But the Note properties dialog box allows you to specify only one font, so this one font would
have to be applied to the whole note - which is certainly not what users would expect (all text formatting in
the note would revert to the font chosen in Note properties dialog box). So what's the Font button for? 
Well, it does have a function: it allows you to choose the INITIAL font for the note - the font which is used 
when you click the "Clear font attributes" command (Ctrl+0). This will normally be the same font you 
selected in "Tools|Default settings". 

Background color and TREE-type notes. 

Because you CAN use a different background color for each node in the tree, the dialog box cannot just 
blindly reset the background color for all nodes. Let's say you have one node in the tree which uses white 
text on black background, and another which has the normal black text on white background. If you press 
F4 while in that latter node, the dialog box will display white background. But if that color was assigned to 
all tree nodes after you click OK, the other note in the tree would now have white font on white 
background. There really is no good solution to this, except that the BG color will only be used as the 
DEFAULT COLOR for NEW nodes that you will later add to the tree (but this depends on whether or not 
you have selected "Inherit background color from active node" in the Options dialog box, "Tree panel" tab,
and yes, I realize this can be confusing.)

If you DO want to change the background color for ALL NODES in a tree, this is still possible. As 
described in the "keyboard.txt" file, hold down the SHIFT key while you click the "Format|Background 
color" command in the menu. KeyNote will then warn you that the new color will be applied to all tree 
nodes, and you can confirm or cancel.



KeyNote menus
The secions below describe each command available through the main menu in KeyNote. Click the links 
for more information.

TIP: A great number of KeyNote menu commands have keyboard shortcuts which invoke these 
commands. The shortcuts are displayed next to the command names. Click here for a complete list of 
keyboard shortcuts in KeyNote.

File menu
Edit menu
View menu
Insert menu
Format menu
Note menu
Tree menu
Search menu
Tools menu
Help menu

TIP: Many areas of the main KeyNote window contain additional context menus. They are often easier to 
use and quicker to access than the main menu. To open a context menu, click the right mouse button. 
For instance, you can right-click the editor area, the tree panel and the note tabs to open context menus 
associated with them.



KeyNote menus: File
New 
Creates a new KeyNote file. If the Auto-Save option is enabled, KeyNote prompts you to give the new file 
a name and save it. Note that the Auto Save option cannot work until you have saved the new KeyNote 
file for the first time.

Open
Opens a KeyNote file on your disk. 

TIP: There are several ways to open a file in KeyNote. You can select a recently used file from the 
"Recent files" menu (see below), you can drag a KeyNote file from Windows Explorer and drop it onto any
area of the main KeyNote window (excluding the editor), or you open a file via the "File Manager" dialog 
box (see below).

TIP: KeyNote can open and save files with the .KNT, .KNE and .N_TEXT extensions. Files of other 
types can be imported.

TIP: Occasionally, KeyNote may open your file in Read-Only mode. For instance, files on CD-ROM 
drives cannot be modified, so they will be opened as Read-Only. The Options dialog box allows you to 
configure which other files should be open in Read-Only mode. When a file has been open in Read-Only 
mode, you can still modify it, but you will not be allowed to save it unless you change the name and/or 
location of the file.

Save
Saves the current KeyNote file to disk.

Save As...
Saves the current KeyNote file to disk with a new name. You can change the name of the file, and its 
location (drive and/or directory).

Close
Closes the current KeyNote file. Note that most KeyNote commands and tools are not available when no 
file is open.

Recent Files
Displays a submenu (optionally) listing the names of files you have recently opened or saved in KeyNote. 
This is a very quick way to open a recently used file. The Options dialog box allows you to configure 
several settings related to the Recent Files menu.

Auto Save
Toggles the Auto Save option. When the option is enabled, KeyNote will save your file automatically. 
When the option is disabled, KeyNote will prompt to save the changes when necessary. The Options 
dialog box allows you to configure several settings related to the Auto Save option.

Properties
Displays the File properties dialog box. Among other functions, this dialog box allows you to securely 
encrypt your KeyNote file, to protect it against unauthorized access.

File Manager
Displays the File Manager dialog box, which allows you to quickly open one of the files you have used in 
KeyNote previously. The File Manager dialog box also displays descriptions and comments associated 
with your KeyNote files, so that you can easily identify them.

Page Setup



Displays the standard Windows "Page Setup" dialog box, which allows you to configure certain aspects of
how your notes will be printed. Note that the settings made in the Page Setup dialog box are ignored if 
you enable the "Safe print" option.

Copy To...
Opens the standard Windows "Navigate to folder" dialog box, which allows you to select a folder 
(directory) to which you want to copy the currently open file. This is a quick way to make a backup copy of
the file, e.g. on diskette. The dialog box will remember the last folder you chose, and automatically open 
with that folder preselected.

Exit
Closes the program.



KeyNote menus: Edit
Undo
Undoes (cancels) the most recent editing operation you performed. The Options dialog box allows you to 
specify the "Undo level", i.e. the number of editing operations that can be undone. Note that you will not 
be able to undo operations after a file has been saved.

Redo
Reverses the last Undo command.

Repeat Last
Repeats the last editing command. Next to the menu command, KeyNote displays the command which 
will be repeated, e.g. "Repeat Bold", "Repeat Paragraph" or "Repeat Paste". This is especially useful 
when the command you want to repeat is buried deeper in the menu structure. You can also press Ctrl+/ 
to repeat the last editing command.

Cut
Cuts selected text and places it on the Clipboard.

Copy
Copies selected text and places it on the Clipboard.

Paste
Pastes data from clipboard. Note that you can not only paste text, but also other data formats which the 
Windows Clipboard can contain, e.g. pictures.

Paste Other
Displays a submenu with the following commands:
· As Text Pastes text from clipboard as plain text (without any formatting)
· Special... Displays the Windows standard "Paste special" dialog box, which allows you to select the 

format which should be used to paste clipboard data.
· Into New Note Creates a new standard note and pastes clipboard data into it.

Delete
Deletes selected text

Lines
Displays a submenu with the following commands:
Delete Line 
Sort Lines
Join Lines

White Space
Displays a submenu with the following commands:
Trim Left
Trim Right
Trim Both
Compress

Change Case
Displays a submenu with the following commands:
To UPPERCASE
To lowercase
To Mixed Case
Invert Case



Transform
Displays a submenu with the following commands:
Apply Rot-13
Reverse Text

Expression
Displays a submenu with the following commands:
Evaluate
Paste Last Result

Copy All
Selects all text in active note and copies it to clipboard.

Select All
Selects all text in active note.



KeyNote menus: View
Always on Top
Toggles the "Always on top" option. WHen the option is enabled, KeyNote's main window will stay on top, 
ie.. will not be covered by any other window.

Toolbars
Displays a submenu of commands which allow you to selectively turn ON or OFF the KeyNote toolbars:
· Show Main Toolbar
· Show Format Toolbar
· Show Style Toolbar
· Show Tree Toolbar
· Show Macro Toolbar
· Show All
· Hide All

TIP: KeyNote toolbars can be dragged and docked in various positions (on top, on the bottom, and 
against the left edge). The can also be dragged to any other position and "float" there. When a toolbar is 
floating, it can be closed. You can also double-click a floating toolbar to dock it automatically (without 
having to drag it into position). The next time you start KeyNote, all toolbars will remember and restore 
their state, size and position

Show Icons on Tabs
Shows or hides icons displayed on note tabs. This menu command will be unavailable (greyed out) if you 
have disabled showing icons for a particular file, via the File properties dialog box.

Show Icons in Tree
Shows or hides icons displayed next to the tree nodes. This menu command is available only if the active 
note is a tree-type note.

Formatting Information
Displays a submenu of commands which allows you to choose what formatting information, if any, should 
be displayed in the status bar:
· Font: displays font style information in the status bar
· Paragraph: displays paragraph style information in the status bar
· Both: displays both font and paragraph style information in the status bar
· Nothing: does not display formatting information in the status bar.
Note that the processing needed to prepare    the information for display will impact the program 
performance.

Alphabetize Tabs
Sorts all note tabs alphabetically, by name

Shift Tab
Displays a submenu of commands which allow you to move the active tab:
· Left: moves the active tab to the left
· Right: moves the active tab to the right
TIP: You can also move note tabs by dragging them with the mouse.



KeyNote menus: Insert
Current Date
Current Time
Character...
File Contents

KeyNote Link
Displays a submenu with the following commands:
Mark Location
Insert Link

URL
Link to File
Picture
Object
Expand Term
WordWeb...



KeyNote menus: Format
Font...
Paragraph...

Font Style
Displays a submenu with the following commands:
Bold
Italics
Underline
Strikeout
Disabled
Superscript
Subscript
Clear attributes

Font Size
Displays a submenu with the following commands:
Increase
Decrease

Alignment
Displays a submenu with the following commands:
Left
Center
Right

Line Spacing
Displays a submenu with the following commands:
Single
One and a Half
Double

Paragraph Style
Displays a submenu with the following commands:
Bullets
First Indent
Left Indent
Right Indent
Space Before
Space After
Clear Attributes

Text Color
Background Color

Highlight Color
Displays a submenu with the following commands:
Apply
No Highlight

Apply Selected Style

Copy Format
Displays a submenu with the following commands:



Font Attributes
Paragraph Attributes

Paste Format
Displays a submenu with the following commands:
Font Attributes
Paragraph Attributes

Word Wrap



KeyNote menus: Note

New Note...

Rename Note

Note Properties

Remove Note

Print Note...

Email Note...

Clipboard Capture

Read Only



KeyNote menus: Tree

Insert Node

Add Node

Add Child node

Move node
Displays a submenu with the following commands:

Delete Node

Delete Child nodes

Rename Node

Paste Node Name
Displays a submenu with the following commands:
From Clipboard
As Date
As Time
As Date and Time

Save to File...

Sort
Displays a submenu with the following commands:
Sort Child Nodes
Sort Full Tree

Expand all

Collapse all



KeyNote menus: Search
Find...

Find Next

Replace...

Replace Next

Set Bookmark

Jump to Bookmark

Match Bracket

Go To Line...

Find Node...

Find Next Node



KeyNote menus: Tools
Configuration Options

Default Settings

Run Macro

Select Macro...

Plugins

Run Last Plugin

Add Glossary Term

Edit Glossary

Merge Notes...

Export Notes...

Import Notes...

Text Statistics



KeyNote menus: Help
Tip of the Day

Help Contents

General Help

Keyboard Reference

Visit Website

Email to Author

About



Special Functions
KeyNote offers a number of "advanced" features and functions. Click the links below to display detailed 
information about these features.

File manager
Encrypting KeyNote files
Sending keyNote files by email
Creating and using styles
Integration with WordWeb thesaurus
Creating and using hyperlinks
Creating and using macros
Using plugins
Word expansion glossary
Insert character dialog box
Clipboard capture
Expression evaluation
Importing files
Exporting files



Encrypting KeyNote files
PLEASE READ THE INFORMATION IN THIS FILE
BEFORE YOU START ENCRYPTING YOUR KEYNOTE FILES!

WARNING: WINDOWS 95/98/NT/ME IS AN INHERENTLY INSECURE SYSTEM!
Any information contained inside a program may be freely "paged" (copied to a swap area on the hard 
disk) by the system's virtual memory manager. That information MAY REMAIN READABLE to a dedicated
snooper, even after you have restarted the system. Special disk-reading utilities that allow this exist and 
are available for free. Currently the program makes no attempt to prevent such paging or swapping of 
data. This means that the information stored in the KeyNote file (*.knt), though encrypted, MAY end up 
somewhere on your hard disk in a clear-text (unencrypted) form.

If you are concerned about this, there exist programs that securely WIPE unused hard disk space and/or 
Windows swapfile. Two of such programs, both freeware, are:

1. RealDelete and Scorch by Iolo Davidson http://www.bonaventura.co.uk/realdelete (small and powerful, 
command-line mode)

2. BCWipe by Jetico, Inc. http://www.jetico.com (Windows GUI program; also distributed as part of 
excellent BestCrypt disk-encryption package)

Please read the "Security considerations" topic for more information on issues related to encrypting 
KeyNote files and potential vulnerabilities.

GENERAL INFORMATION

As of version 0.90 beta, KeyNote supports secure encryption. Each KeyNote file can be encrypted using 
one of the two supported algorithms (Blowfish and IDEA). This allows you to protect your sensitive data 
with an access passphrase. An encrypted file cannot be opened without entering the passphrase that was
used to scramble it.

CAUTION! IF YOU FORGET YOUR PASSPHRASE, YOU WILL NOT BE ABLE TO ACCESS YOUR 
ENCRYPTED KEYNOTE FILE!

There are no backdoors, and the cipher algorithms used have no known weaknesses which would allow 
you - or anyone - to crack the ecnryption, even using a brute-force attack.

Note that this is the first release of KeyNote which supports encruption. At the moment, I know of no bugs 
related to this feature, but this does not mean there are none. Please use the encryption feature 
cautiously and backup your data frequently. Please do report any problems or bugs you find.

HOW TO ENCRYPT YOUR KEYNOTE FILE

Create a new file or open an already existing .KNT file. To encrypt the file, press Alt+Enter to open the 
"File Properties" dialog box (or choose "Properties" from the "File" menu).

Click the "Format" drop-down list, and select "Keynote encrypted file" as the format which should be used 
to save the file. When you do this, another tab will appear in the dialog box, called "Security".

Click the "Security" tab. Decide what access passphrase you want to use, and enter in in the 
"Passphrase" edit field. Next, enter the same exact passphrase in the "Confirm pass" edit field. This is to 



make sure that you did not accidentally mistype the passphrase.

Note: the passphrase cannot be shorter than FIVE characters. However, a truly secure passphrase 
should be much longer (10-30 characters). Ideally, your passphrase should not contain only letters of 
alphabet, but also digits and punctuation characters, including space. Remember that the passphrase is 
case-sensitive. To open the encrypted file, you will have to enter the passphrase PRECISELY as you 
typed it in this dialog box.

You may also choose which cipher algorithm to use: Blowfish or IDEA.

Click OK.

When the file is subsequently saved, it will be stored on your disk in encrypted state. When you later open
this file, KeyNote will prompt you for the access passphrase. KeyNote will not be able to open an 
encrypted file if you do not supply the correct passphrase.

Note: If you close the file or exit KeyNote without saving the file, the changes made in the "File 
Properties" dialog box will NOT be retained (and the file will remain unencrypted). if you have the 
AutoSave option turned ON, KeyNote will save the changes automatically.

HOW TO CHANGE ACCESS PASSPHRASE FOR AN ALREADY ENCRYPTED FILE

Open en encrypted file and enter your passphrase when prompted. Press Alt+Enter to open the "File 
Properties" dialog box (or choose "Properties" from the "File" menu).

Click the "Security" tab.

Click the "Set Passphrase" button, and enter the new access passphrase in the "Passphrase" and 
"Confirm pass" edit fields, as described above.

Click OK.

Note: If you close the file or exit KeyNote without saving the file, the changes made in the "File 
Properties" dialog box will NOT be retained (and the file will remain encrypted with the original, 
unchanged passphrase). If you have the AutoSave option turned ON, KeyNote will save the changes 
automatically.

HOW TO STOP ENCRYPTING YOUR KEYNOTE FILE

Open en encrypted file and enter your passphrase when prompted. Press Alt+Enter to open the "File 
Properties" dialog box (or choose "Properties" from the "File" menu).

Click the "Format" drop-down list, and select "Keynote native file" as the format which should be used to 
save the file. The "Security" tab will disappear.

Click OK.

Note: If you close the file or exit KeyNote without saving the file, the changes made in the "File 
Properties" dialog box will NOT be retained (and the file will remain encrypted). If you have the AutoSave 
option turned ON, KeyNote will save the changes automatically.

NOTE ABOUT the BLOWFISH and IDEA CIPHER ALGORITHMS



KeyNote supports two encryption algorithms: te Blowfish and IDEA. These two ciphers were used in 
KeyNote, because their use is not restricted by patent laws (Blowfish) or because, while patented, they 
are free for non-commercial use (IDEA). If you use KeyNote in commercial environment, you should only 
use the Blowfish cipher, which is the default choice.

For detailed descriptions of the crypto algorithms used, see:
BLOWFISH: http://www.counterpane.com/blowfish.html
IDEA: http://www.momentus.com.br/PGP/doc/idea.html

SECURITY CONSIDERATIONS

· If you have not yet read the WARNING at the top of this file, please do so now.

· BACKUP files: Typically, KeyNote is configured to maintain the previously-saved version of your file as 
backup; these files have the ".bak" extension. One potential vulnerability related to backup files is that it
is possible for the backup file to remain unencrypted, after your KeyNote file was saved in encrypted 
state. If you create a new KeyNote file, save it, and then decide to encrypt it, the encrypted file will be 
saved, and the previous version of it will be renamed with the ".bak" extension. The previous version - 
preserved as backup - is unencrypted. After you save your KeyNote file again, the new backup will be a
copy of the already encrypted file. Note that the same applies to a situation when you change the 
access passphrase of the encrypted file: the first time you save the file, the backup is a copy of the file 
encrypted with the previously used passphrase.

· If you use the "Virtual nodes" that KeyNote supports since version 0.91, please note that the actual files
on disk which are linked to virtual nodes are NOT encrypted. They cannot be, because if KeyNote 
encrypted them, you would not be able to open those files in applications other than KeyNote, thus 
rendering the virtual nodes useless and potentially destroying data. A warning is displayed the first time 
you add a virtual node to an encrypted file or encrypt a file that has virtual nodes.

· The access passphrase only protects your file when it is encrypted on disk. When KeyNote is running 
and has the file open, the file may be viewed or edited by anyone who can use your computer, until you
close the file. In a future release of KeyNote an option may be added to close the file when the program
is minimized, and automatically attempt to reopen it (prompting for passphrase) when KeyNote is 
restored. This feature is not yet present.

· If you need more security then KeyNote offers, or if you need to securely encrypt data files created by 
other applications, you may consider using disk encryption software instead. Such software encrypts all
files on a selected disk partition, thus securing ALL your data and programs. There are freeware disk 
encryptors, such as ScramDisk, and commercial solutions. Users of PGP may note that www.pgpi.com 
has a freeware version of PGP which includes the PGPDisk module. An additional advantage of such a 
solution is that you only need to remember ONE passphrase for accessing all your encrypted data - 
and any new software installed or any new data files placed on the encrypted disk partition are 
immediately protected without any additional effort on your part.

MISCELLANEOUS NOTES

· KeyNote allows you to save data in the format used by a similar application, called DartNotes (see file 
"dart.txt"). However, since DartNotes does not support encryption, you cannot encrypt files saved in this
format.

· Using the File Properties dialog box, you can add an optional description and comment to each file. If 
the file is encrypted, the description and comment are encrypted as well. However, they will be 
displayed IN CLEAR-TEXT in the File Manager dialog box, which is NOT protected by a password. This



may be changed in the future, but for now the description and comment strings are not secure, even if 
the actual file is.

-----------------------------------------------------------

Crypto algorithms used: DCPCrypt, Delphi cryptographic component package by David Barton:
http://www.devarchive.com/DCPcrypt.html

If you are interested in how the DCPCrypt package was used in KeyNote, you can download the 
cryptography-related parts of KeyNote source code from 
http://www.lodz.pdi.net/~eristic/free/kntsrc.zip



Sending KeyNote files by E-mail
As of version 0.70, Keynote allows you to send notes via E-mail directly from the program. Click the note 
you want to send, then press Ctrl+Shift+E, or choose the "Email note" command from the "Note" menu.

The first time you do this, you will need to configure a small number of settings - excactly the kind of 
setting you once had to configure in the email program you use. Click the "SMTP server settings" tab 
and enter the name of the SMTP server (i.e. the server for outgoing email). You do not need to change 
the default setting in the "Port" box, unless your server uses a non-standard port (stabdard is 25).

In the "From" box, enter your own email address, in the form "johndoe@example.com" (without the 
quotes)

These settings will be retained. You only have to enter them once.

Click the "Message settings" tab. First, you can choose what should be sent. You can send the 
currently displayed note only, all notes, or the whole Keynote file. (In the latter case, please make sure the
recipient has Keynote installed, otherwise they won't be able to open the file you send them.)

If you are sending a single note, you can choose whether to send it as plain text (in the body of the email 
message) or as a Rich Text Format (RTF) file (the file will be attached to the message).

If you choose either of the remaining options (All notes or File), the Plain text vs. RTF choice is disabled.

Type the recipient address in the "To" edit box. You can enter more than one address in both "To" and 
"Cc" edit boxes; separate addresses with commas; e.g.:

user@example.org, jane@abc.com, john@123.net

Type the subject in the "Subject" edit box. By default, the subject is prefilled with the name of the selected
note.

Click the "Send" button. Information about progress and any errors that might occur is displayed above 
the button. Wait until the email is sent, then click the "Close" button. While the program is sending your 
message, you might click the "Abort" button or hit the ESC key to cancel sending.

Additional information:
There are two text files in the Keynote directory which you may edit to your purposes. These are plain text
files and should be edited using a text editor, such as Notepad.

The file "keymail.adr" is a very simple address book. The contents of this file are automatically loaded into
the "To" and "Cc" dropdown lists. Put email addresses in this file, one address per line, without any 
punctuation. You can then click the down-arrow icon in the "To" and "Cc" edit boxes, to quickly select a 
recipient's address.

The file "keymail.sig" is a signature file. Its contents will be automatically appended to each email 
message you send from Keynote. Delete this file if you don't want to append any signature.



Styles
GENERAL INFORMATION ABOUT STYLES

KeyNote now supports a "Style" feature. A style is a combination of formatting properties (such as font 
name, size, and color) which you can define under a name that you choose, and apply to the selected 
text. This makes it easy to format text quickly, without going through all the individual menu options and 
dialog boxes.

KeyNote supports three types of styles, differeing in the "range" of properties they hold:

1. Font styles: only font formatting information is included in the style; applying the style to text changes 
the font formatting, but does not affect existing paragraph formatting.

2. Paragraph styles: only paragraph formatting information is included in the style; applying the style to 
text changes the paragraph formatting, but does not affect existing font formatting.

3. Combined styles: both font and paragraph formatting is included in the style, and aplying the style 
alters the font and paragraph properties of the text.

All font properties (including Highlight) and/or paragraph properties which you can set through the 
"Format" menu commands can be included as part of the style definition.

KeyNote now comes with a sample style file (keynote.kns). You can use the styles defined there, or you 
can add your own.

HOW TO CREATE STYLES

To be able to create or use styles, you must make sure that the new "Style" toolbar is visible. The toolbar 
contains a single drop-down box, which lists all the available styles, and a button with a drop-down menu.

To create a style, you must first format some text in the note to have the appearance which you want to 
define a style for. (There is no separate dialog box for defining style properties.) For instance, if you want 
to make a style which will use blue, underlined Sans Serif font, add some text to the note and format it 
that way using the Font dialog box. (You can later delete that piece of text.) You can also specify 
paragraph formatting, if you wish to include that in the style you are creating.

Click anywhere within that piece of text. When you create a new style, KeyNote will define the style using 
the font and/or paragraph properties at the insertion point (caret).

Next, click the arrow next to the button on the Style toolbar. A menu will be displayed, including these 
three commands:

· Create Font Style
· Create Paragraph Style
· Create Combined Style

Click the command appropriate for the type of style you wish to create (the three types are described 
above). KeyNote will prompt you for the name under which the style will be saved. Type the name, or click
Cancel to abort the procedure.

Note: style names must be unique. If you specify a name that already exists in the style list, you will only 
be able to replace the old style with the new definition (i.e. redefine the existing style instead of adding a 
new one).



The new style will be created and added to the Style selection drop-down box on the Style toolbar.

HOW TO APPLY STYLES TO TEXT

Again, you must make sure that the Style toolbar is visible. Click the style you wish to use, and then click 
the Apply button on the Style toolbar.

The properties stored in the style will be applied to the selected text in the note, or to the text at the 
insertion point if no text is selected (just like when you click the Bold button, for instance).

Note that when you click a style name in the drop-down box, its properties are displayed in the status bar. 
You can also use the "Describe" command in the button menu to display information about the style in a 
more convenient diaog box.

Note also that each style name in the drop-down box is accompanied by an icon which corresponds to the
type of style (font, paragraph or combined).

TIP: To select a macro without clicking the mouse, press "Ctrl + Grey *" (the * key on the numeric 
keypad). You can then press ENTER to apply the selected style, or press ESC to return to the editor.

OTHER STYLE COMMANDS

Other style commands are accessible through the drop-down menu attached to the "Apply" button on the 
Style toolbar. There is a command to Apply the selected style, which is equivalent to pressing the Style 
button. There are also the three commands used to create new styles (described above).

Other commands are:

Describe style 
Displays a dialog box with detailed information about the type of the selected style and all the formatting 
properties it contains. (Note that color names will only be meaningful if the style color is one of the 
standard Windows colors.)

Redefine style
Similar to Create, but the new style will replace the properties of the currently selected style. This is useful
for modifying an already existing style: apply it to a piece of text, make modifications to the formatting, 
then click "Redefine". KeyNote prompts you before making the change.

Rename style
Allows you to change the name of the selected style. Please see the note about unique style names, 
above.

Delete style
Permanently removes the style definition. Note that there is no limit on the number of styles you can 
define, but with too many of them, the drop-down list may become inconvenient to navigate. You can use 
this command to get rid of unnecesary styles.



Integration with WordWeb thesaurus
Starting from version 0.89 A, KeyNote has a special feature which allows you to look up words in a 
thesaurus called WordWeb. The feature is accessed by clicking the "W" button on the main toolbar, or by 
clicking the "Look up in WordWeb" command in the right-click context menu of the RTF editor.

To use this feature, you will of course need to install WordWeb on your computer. WordWeb is a fantastic 
freeware dictionary and thesaurus (there's also a more powerful shareware version available).

WordWeb can be downloaded from http://wordweb.co.uk/free (WordWeb is distributed as 
freeware; there is also a more advanced commercial version.)

After installing WordWeb, please make sure that the file "wweb32.dll" was placed in the C:\WINDOWS 
directory (or C:\WINNT), or in some other directory which is accessible via the system path, such as C:\
WINDOWS\SYSTEM. Otherwise KeyNote will not able to find this file and consequently to start 
WordWeb.

USING the "LOOK UP IN WORDWEB" FUNCTION:

Double-click the word which you wish to look up in the dictionary, then click the WordWeb button on the 
toolbar, or right-click the selected word and choose the "Look Up in WordWeb" from the context menu. If 
no text is selected when you use the command, KeyNote will prompt you for a word to look up in the 
thesaurus.

Keyboard shortcut: Ctrl+F11

In WordWeb, you can select a word in the synonym list and click the "Copy" button. This will cause 
WordWeb to close, and the word you copied will replace the original selected word in KeyNote's editor.

KeyNote uses the freeware WordWeb integration component written by Mr. Antony Lewis 
(http://www.x-word.com/wwdev/).



Hyperlinks in KeyNote
GENERAL INFORMATION ABOUT HYPERLINKS

KeyNote supports clickable URLs (hyperlinks) in the extent that the standard RichEdit control (riched2.dll)
allows. In general, the RTF editor recognizes and highlights hyperlinks which follow the standard format 
for internet URLs. For instance, if you type or paste the following in a note:

http://www.example.com

this text will be treated as a clickable link (unless you have turned off URL recognition for the particular 
note using the Note Properties dialog box).

Hyperlinks are always underlined and displayed in blue. The RichEdit control does not allow for 
customizing the style or color, which makes the feature somewhat less useful if you have a note with a 
dark background, for instance.

The RichEdit control recognizes and highlights standard URL schemes, e.g. http://, ftp://, mailto:, telnet: 
etc. It also supports the "file:///" URL, which you can use to create links to files and programs on your 
computer.

ACTIVATING HYPERLINKS

By default, hyperlinks are activated by a single mouse-click.

This may sometimes be annoying, so KeyNote introduces an option which requires pressing the Shift key 
while the URL is being clicked. To turn this option on, open the Options dialog box, click the "Misc" tab, 
and put a check in the "Require Shift key with URL click" checkbox.

You can also specify what action KeyNote should take when a hyperlink is clicked. In the "Misc" tab, 
select the action you want to use as default from the "On URL click" drop-down list.

Note about "http://" hyperlinks:

Often you will want the URL to be opened in a new browser window, instead of the window that is 
currently open. You can specify that URLs should always be open in a new browser window by selecting 
the "Open in new window" option from the "On URL click" drop-down list. Regardless of this setting, URL 
will also be opened in a new browser window if you hold down the CTRL key while clicking the URL.

Note that KeyNote will not recognize URL clicks in notes for which you turned off the "Detect and highlight
URLs" option in the Note Properties dialog box.

INTERNET HYPERLINKS

The easiest way to add a typical URL is to simply paste it from clipboard, or to type it in. If the editor 
recognizes the text as a valid URL, the text will become underlined and marked in blue as you type.

However, some URLs must be encoded in a special way, e.g. if they contain spaces. (See the 
"Limitations" section, below.) For such URLs, it is best to use the "URL" command located under the 
"Insert" menu. Paste or type the URL in the dialog box that will be displayed, and KeyNote will 
automatically encode any special characters so that the URL is recognized and displayed correctly.

The "Insert URL" command will also try to detect when you are inserting an email address, and it will then



automatically prefix the address with the "mailto:" URL scheme.

HYPERLINKS TO LOCAL FILES

One of the standard URL schemes is "file:///". It allows you to create hyperlinks to documents or programs
on your computer. For instance, if you click a link to a .xls file, the file will be opened in Excel. If you click 
a link to a program, the program will be executed.

If the link points to a file that KeyNote supports (a file with the .KNT, .KNE or .N_TEXT extension), then 
the file will be opened in KeyNote, just as if you have used the "File|Open" command.

To insert a hyperlink to a file on your computer, use the "Link to file" command located under the "Insert" 
menu.

Sometimes you may see an error message displayed when you click a file:/// link. The most common is 
"Error code 2". This means that the file could not be found or accessed: the file probably does not exist, 
was renamed or moved to another place.

IMPORTANT NOTE: Unlike other URLs, the "file:///" URL must usually contain three forward slashes, not 
two. This is required by the logic of the URL format: the third slash means "the path starts at the root 
directory". It allows for creating hyperlinks to files located on another computer on a network: the name of 
that computer would be placed before the third slash:

file://computername/c:\users\files\document.txt
Normally, you will be linking to files on your own computer: in such a case, the computer name is not 
given (blank), but the third slash must always be present.

KEYNOTE LINKS (HYPERLINKS TO OTHER NOTES)

The last type of hyperlinking that KeyNote supports is the ability to link to other notes and tree nodes in 
KeyNote files. You can create hyperlinks to places in the same (current) file, or any other KeyNote file on 
your computer.

Basically, this is an extension of the "file:///" URL, so everything written in the section above applies here 
as well.

Inserting a "KeyNote link" requires two steps: marking the target, i.e. the place to which the link will jump, 
and then inserting the link somewhere else.

1. In the editor, position the caret or click the place to which you want to create a link. Clicking the link will 
jump here. In the "Insert" menu, click the "KeyNote link", and then click the "Mark Location" command in 
the submenu.

2. Navigate to the place where you want the link to appear. This can be any place in any note, in the file 
that is currntly open or in another file. (You can close the current file and open another one.) Click the 
place in the editor where you want to insert the link. In the "Insert" menu, click the "KeyNote link", and 
then click the "Insert Link" command in the submenu.

A KeyNote link will be inserted. Clicking this link will jump to the location which you marked in step 1. Try 
it!

In order to be able to jump to a selected place in a file, KeyNote uses a special extended syntax for such 
links. KeyNote creates the links automatically and you do not have to worry about the special syntax - but 
it looks like this:



a) link to a place in the current KeyNote file:
file:///?NoteName|NodeName|CursorPosition|SelectionLength

b) link to a place in another KeyNote file:
file:///Path_to_File.KNT?NoteName|NodeName|CaretPosition|SelectionLength

Explanation:

file:/// standard URL scheme prefix
Path_To_File full path to the .KNT file to which the link points. If the link points to a location in 
the same file in which the link is inserted, the path is omitted.
? Since the question mark character cannot be present in a filename on a Windows 
system, it tells KeyNote that this is the special kind of link, the "KNT link".
NoteName The name of the note to which the link will jump
NodeName The name of the tree node to which the link will jump, if the target note is a tree-
type note. If the target note is a plain RTF note, the NodeName section is blank.
CaretPosition The position, in the editor, where the caret will be placed after the jump.
SelectionLength The length of the text that will be selected after the jump. Normally it is 0, but if a 
porion of text was selected when you clicked the "Mark Location" command, the link will remember this 
and will restore the selection when you jump.

The special sections of the link are separated with the '|' character.

The NodeName, CaretPosition and SelectionLength sections are optional and need not be present for the
hyperlink to work. The following hyperlinks are all valid:

file:///c:\My%20Documents\diary.knt?BlueNote|Monday|30|0 
- open the file called "diary.knt", switch to the note called "BlueNote", select the "Monday" node in the 

tree, and position the caret at character number 30

file:///?BlueNote|Monday|30|0
- in current file, switch to the note called "BlueNote", select the "Monday" node in the tree, and 

position the caret at character number 30

file:///?BlueNote|Monday|30
- same as above

file:///?BlueNote
- in current file, switch to the note called "BlueNote". (Caret will be positioned at the start of the note)

IMPORTANT: There is one significant limitation to how KeyNote links work. Notes and tree nodes are 
identified by their names. In the above example, the link jumps to a note called "BlueNote". KeyNote 
searches the file and switches to the first note with this name that it finds. This means that the link will not 
work well if you have more than one note (or tree node in a note) with the same name. The link will work, 
but it will always jump to the FIRST note (or tree node) which has the name specified in the link.

LIMITATIONS

· It is not possible to change the color or font style used to highlight URLs in the editor. The RichEdit 
control does not support this, and always shows URLs in blue underlined font.

· Email addresses will only be highligted if they are inserted in the form of a full URL. For example, 
"wizard@oz.org" is a correctly formed email address, but it is **not** an URL, and will not be 
highlighted. In order to create a highlighted, clickable email address, you must prefix it with the name of
the URL scheme, which is "mailto:' for email:



    mailto:wizard@oz.org
    This prefix is added automatically when you use the "Insert URL" command.

· You cannot add custom URL schemes.

· When you turn URL highlighting on or off for a particular note, the change is honored after you reload 
the file. This is, again, a limitation of the RichEdit cotrol. In some cases, the URLs will not get un-
highlighted even after you have turned URL highlighting off and reloaded the file. To correct this, select 
the URL and click Ctrl+0 to clear the special fonr formatting.

· As defined by Internet standards, URLs cannot contain spaces and certain other special characters. 
The RichEdit control behaves correctly in this respect and does not allow spaces in URLs, either. 
Spaces and other special characters must be converted to hexadecimal codes, e.g. %20 for space. 
KeyNote does this for you automatically, but note that such a notation impairs the readability of URLs.

· The "Insert URL" command does not verify the format of the URL you are inserting. In other words, you 
can use it to insert just about any line of text, and it will not complain. The command only formats the 
special characters in the text (by replacing them with numeric codes) and, if it detects an email address,
prefixes the address with the "mailto:" scheme name.



Macros in KeyNote
Update: Macros are now displayed on the Resource panel. Press F9 to display the resource panel.

GENERAL INFORMATION ABOUT MACROS

As of version 0.999, KeyNote supports macros. You may already know macros from other word-
processing applications. A macro is a list of commands executed in a program, which is stored on disk 
and can be replayed. This allows you to automate certain repetitive tasks, such as typing or formatting 
text.

To use macros in KeyNote, first turn on the "Macros" toolbar, which is not displayed by default. Click the 
"View" menu, then click "Toolbars", and select the "Show macro toolbar" command. The toolbar is 
described in more detail in "The Macro toolbar" section, below.

Macros are text files with ".KNM" extension, and they must all be located in the "macros\" subdirectory, 
below the directory when KeyNote is installed. For example, if KeyNote is installed in

c:\Program Files\Keynote
then all plugins should be placed in

c:\Program Files\Keynote\Macros
This subdirectory is automatically created by the Setup program.

Macros are created by "recording" commands. After you start recording a macro and give it a name, the 
keypresses and editing commands you issue in KeyNote are recorded until you click the "Stop" button. 
Then the macro is saved to disk and can be replayed, to repeat exactly the same actions you made while 
recording.

NOTE: Not all KeyNote commands and functions can be recorded in a macro. Please see the 
"Limitations" section for details.

To learn about recording and replaying macros, see the sections "Creating (Recording) Macros" and 
"Using (Replaying) Macros".

THE "MACRO" TOOLBAR

To use macros in KeyNote, you should turn on the "Macros" toolbar, which is not displayed by default. 
Click the "View" menu, then click "Toolbars", and select the "Show macro toolbar" command.

The toolbar contains a drop-down list and several buttons.

The drop-down list contains all available macros. The macros are listed alphabetically by their descriptive 
names (rather than the filenames). The icons displayed next to the macro names indicate the type of the 
macro. Currently, there are two different icons for two different types of macros: "normal" and "Auto-run" 
macros. Please see the "Auto-run Macros" section, below, for a description of this type.

TIP: To select a macro without using the mouse, press "Ctrl+ Grey /" (the / key on the numeric keypad). 
You can then press ENTER to run the selected macro, or press ESC to return to the editor.

TIP: When you select a macro in the list, a short description is displayed in the status bar to help you 
identify the macro.

To the right of the drop-down list, there are three buttons:

PLAY



Replays the macro selected in the drop-down list.

PAUSE
Pauses the recording. It is only available while you are recording a macro. When recording is paused, the 
commands you use and keys you press are not added to the macro.

RECORD
Click this button to create a new macro and start recording.

The PLAY button also has a drop-down menu. Click the down-arrow next to the button to open the menu. 
The menu contains the following commands:

"Play macro"
Replays the macro selected in the drop-down list.

"Edit macro"
Displays a dialog box which allows you to change the name and description of the selected macro,

"Delete macro"
Deletes the macro selected in the drop-down list.

"User command..."
This command is only available while recording a macro, and it allows you to insert a special user 
command at any point in a macro. See the "Editing Macros; Special User Commands" section for more 
information.

CREATING (RECORDING) MACROS

First, make sure that the "Macros" toolbar is visible, as described in the "General Information" section.

1. Click the "Record" button on the "Macros" toolbar to create a new macro.
2. In the dialog box displayed, enter the name for the new macro, and (optionally) a short description.
3. When you click OK, recording will begin.
4. Work in KeyNote as you would normally. The keys you press and the editing commands you choose 
will be recorded in the macro.

- At any point during recording the macro, you can open the drop-down menu on the "Macros" toolbar 
and click "User command..." to enter one of several predefined user commands to the macro.

- While recording, you may also click the "Pause" button on the "Macros" toolbar. Recording will be 
paused until you click the "Pause" button again. While recording is paused, you can still work in KeyNote, 
but the keypresses and commands will not be included in the macro.
5. Click the "Stop" button on the "Macros" toolbar to finish recording the macro. KeyNote will ask 
whether the newly created macro should be saved. Click Yes to save the macro in a ".KNM" file, or click 
No to discard it.

The newly recorded macro will be added to the "Macros" toolbar. It can be replayed by clicking the "Play" 
button.

NOTE 1: Macro names must be unique. When creating a new macro, the name you enter must not be the
same as the name of one of the already existing macros.

NOTE 2: The dialog box which allows you to enter the name and description for the new macro contains 
one additional option: "Abort macro when error occurs". If this option is checked, the macro will stop 
whenever an error condition is detected while replaying the macro.

NOTE 3: Sometimes, while recording a macro, you will issue a command which causes a dialog box to be



displayed. For instance, you can use the "Font" or "Paragraph" commands to change the font or 
paragraph attributes via a dialog box. When you click OK in the dialog box, a prompt will be displayed, 
asking you what should happen when the macro is replayed later. While replaying the macro, KeyNote 
can use the values you have just entered in the dialog box, or it can display the dialog box so that you can
enter different values every time you replay the macro. You can also click Cancel to skip the dialog box 
and omit it from the macro. If you choose to have the dialog box displayed while the macro is replayed, 
and if, while replaying the macro, you will click Cancel in the dialog box, the macro will be aborted.

USING (REPLAYING) MACROS

1. Playing macros by using the tolbar:

First, make sure that the "Macros" toolbar is visible, as described in the "General Information" section.

Select the macro you want to play from the drop-down list on the "Macros" toolbar. Next, click the "Play" 
button.

TIP: To select a macro without using the mouse, press "Ctrl+ Grey /" (the / key on the numeric keypad). 
You can then press ENTER to run the selected macro, or press ESC to return to the editor.

TIP: When the "Macros" toolbar is displayed, you can press Shift+F5 at any time to play the currently 
selected macro.

2. Playing macros without using the "Macros" toolbar:

From the "Tools" menu, choose the "Select macro" command. A standard file-selection dialog box will be 
displayed. Select the file which contains the macro you want to run, then click "Open". The selected 
macro will be replayed.

TIP: If you have installed a macro manually while KeyNote is running, by copying the .KNM file into 
KeyNote's macro directory, the list of Macros must be refreshed before KeyNote will notice the new 
macro. To refresh the list, hide the "Macros" toolbar and the show it again.

NOTE: While a macro is being replayed, you can press ESC to stop and abort the macro. You cannot 
pause a running macro, however.

"AUTO-RUN" MACROS

KeyNote supports a special type of macros, called "Auto-run" macros. These macros may be 
automatically replayed after a new file has been created, after you have added a new note to a file, etc. In
the drop-down list of macros on the toolbar, these Auto-run macros are indicated by a special double-
arrow icon.

Auto-run macros are disabled by default. To enable them, open the "Options" dialog box (press F5), click 
the "Advanced" tab, and check the "Allow Auto-run macros" option.

KeyNote recognized Auto-run macros by their filenames. The names of all auto-run macros begin with 
"_Auto".

Currently, KeyNote supports three Auto-run macros:

_AutoNewFile.knm
This macro is executed automatically after a new file has been created. The sample macro supplied 
automatically adds a single tree-type note in the newly created file. This allows you to replace KeyNote's 



standard behavior, whereby a new "simple RTF" not is created instead.

_AutoNewNote.knm
This macro is executed automatically after a new "simple RTF" note has been added to the current file. 
The sample macro supplied inserts current date and time at the top of the new note.

_AutoNewTree.knm
This macro is executed automatically after a new tree-type note has been added to the current file.

In order to replace these sample macros with your own Auto-run macro, record a new macro, save it, and 
rename the .KNM file using one of the filenames above.

EDITING MACROS; SPECIAL USER COMMANDS

In general, KeyNote macros are not intended to be edited by hand. However, macros are simple text files,
where each line contains a single KeyNote command, they may be edited manually in a text editor, and 
future versions of KeyNote will provide functions to facilitate editing macros.

Apart from the keypresses and commands that are recorded and stored in a macro, KeyNote supports a 
range of special user commands, which can be inserted in macro files. These commands complement 
and extend the range of editing functions that can be recorded.

To add a user command to a macro:
1. Start recording a macro normally
2. At the point where you want to insert a user command, click the down arrow button on the "Macros" 
toolbar, and select "User command".
3. A dialog box will be displayed, listing all available user commands. Select the command you need, and,
if necessary, type in the argument string. The dialog box displays information about the function and 
xyntax of the selected command.
4. Click OK to add the command to the macro.

User commands may also be simply typed in a macro file.

NOTE: The range of available user commands is limited at present. If there is enough interest in such a 
feature, more commands may be added and their syntax may be extended.

SYNTAX
User commands require the following syntax:
@COMMAND(argument)

- they must begin with the '@' character
- they must be typed in UPPERCASE
- if required, they must include the argument string enclosed in parentheses.

Not all commands require arguments, and for some commands, the argument is optional. If an argument 
is optional, KeyNote will use a default setting for the given command. Otherwise, the macro will be 
aborted if a required argument is missing.

EXAMPLES:

To see some of these commands as they are actually used, view the source of the macros installed with 
KeyNote, especially the "Auto-run" macros.

@CONFIRM(text)
- displays "text" in a confirmation dialog box with OK and Cancel buttons. If the user clicks the OK 



button, the macro will continue. If the user clicks the Cancel button, the macro will be aborted. This is very
useful as a first line in a macro that should not be executed "by mistake".

@INSERT(text)
- inserts "text" in current note. Use "\n" to mark a line break, and "\t" to mark a tab.

@MACRO(macro filename)
- executes the specified macro. The filename must contain the .KNM extension, but NOT the path (i.e.

filename part only). After the specified macro has been executed, the current macro will continue.

@MESSAGE(message text)
- displays a dialog box with the message text. Use "\n" to mark a line break, and "\t" to mark a tab.

@NEWNOTERTF
- creates a new "simple RTF" note in the current file

@NEWNOTETREE
- creates a new tree-type note in the current file

@PLUGIN(plugin filename)
- executes the specified plugin. The filename must contain the .KNL extension, but NOT the path (i.e. 

filename part only)

@REWIND
- replay macro from the beignning
WARNING: Will cause macro to run forever in an infinite loop, until user presses ESC or until an error 

occurs.

@STYLEON(bold|italic|underline|strike)
@STYLEOFF(bold|italic|underline|strike)

- STYLEON turns ON the specified font style.
- STYLEOFF turns OFF the specified font style.
The argument string may contain only 1 style, e.g.
@STYLEON(bold)

@WAIT(miliseconds)
- pauses the macro for the specified time

LIMITATIONS

Some of the following restrictions may be lifted in future releases of KeyNote. However, I cannot promise 
that I will be able to do so. The tree-related commands are particularly difficult to handle from within 
macros, since there is no guarantee that any command that modifies the tree can be correctly executed 
while the macro is replayed.

I. Limitations on macro names

Macro names must be unique. No two macros can have the same name.

II. Limitations on macro commands

Certain KeyNote commands cannot be recorded in a macro. They will be executed while recording, but 
they will not be stored in the macro file.

Macros CAN contain the following:



- Keypresses in the RTF editor (*not* in the tree panel)
- All "Edit" and "Format" menu commands, e.g. selecting a font name, size or style, setting paragraph 
attributes, changing text or highlight color, clipboard operations, and many others.
- Some "Insert" menu commands: inserting date, time, and special characters; glossary expansion
- Some "Search" menu commands (Find; Go to line; Match Bracket)
- All caret navigation commands restricted to current note.
- Setting and jumping to bookmarks.

Macros CANNOT contain:

- Mouse clicks. You can only use keyboard, toolbar and the menu commands while recording a macro. 
(To select a word, use the Alt+W keyboard shortcut instead of double-clicking the mouse.)
- Any tree-related commands (i.e. a macro cannot create, move, rename or detele tree nodes)
- Any tree or note navigation commands which cause a different tree node or a different note to be 
displayed (NOTE: You *can* set and jump to bookmarks.)
- Note management commands, such as creating, renaming, deleting, printing, mailing notes
- Insert menu commands (except the commands listed above), bookmark and hyperlink commands
- Drag and drop operations
- Import and export commands
- Setting options, preferences or properties (file or note properties).
- File-related commands (New, Open, Save, Copy to, etc.)

Note that the special user commands which you can insert in a macro allow you to overcome some (not 
all!) of these limitations.

There are no flow-control or branching macro commands. There are no macro commands which take 
user input, except the standard editing/formatting commands, some of which display input dialog boxes.

Other limitations:

- "Find"
    The dialog box will NOT be displayed while replaying the macro.
    The command will be executed with the parameters you specified
    in the dialog box while recording the macro.
    
    In addition, certain Find options are disabled while recording
    a macro. The only available options are "Match case" and "Whole
    words only".

- "Insert special character"
    The dialog box will NOT be displayed while replaying the macro.
    The command will be executed with the parameters you specified
    in the dialog box while recording the macro.

- "Apply style"
    The macro will record the name of the style applied, and will apply
    that style when replaying (rather than applying the style which is
    currently selected in the Style list). This is necessary because
    there is no guarantee that the Style toolbar will be visible when
    the macro is being replayed, hence there might be no style available
    for selection.
    
- "Replace"
    This command CANNOT be recorded in a macro.



III. Limitations on replaying macros

When replaying a macro, KeyNote must be the topmost window, and the RTF editor must have focus. 
This is normally not a problem, since KeyNote must be active for you to activate (play) a macro. However,
if you switch to another application while a macro is being replayed, the macro will PAUSE, and will 
resume automatically when you return to KeyNote. I'll try to remove this limitation in a later release.

MACRO FILE SYNTAX

A macro file is a plain text file with the .KNM extension.

The first line in the macro is a header line. This line must be present and correctly formatted, otherwise 
the macro will not be executed.

Header line syntax:
;1.0|Macro Name|Macro description|Abort on error?|Creation Date

Each subsequent line in the file contains a single macro command. Lines are executed in sequence.

Blank lines are ignored.

Lines beginnig with semi-colon (;) are treated as comments and ignored.

Lines beginning with the "at" (@) character are interpreted as user commands.

Lines beginning with the hash (#) character are interpreted as internal commands.

Other lines are interpreted as keypress codes. A keypress code contains the key scan code and shift 
state string, separated by the vertical bar (|) character. E.g., Shift+Enter is encoded as:

13|S
Shift states are indicated by a single capital letter:

S - Shift
C - Control
A - Alt

Shift states may be combined. E.g., Ctrl+Alt+Backspace is encoded as
8|CA

Any line not conforming to the above specifications will cause a macro execution error.



Plugins
Update: Plugins are now displayed on the Resource panel. Press F9 to display the resource panel.

PLUGINS: GENERAL INFORMATION FOR USERS

As of version 0.999, KeyNote supports a simple but effective plugin technology. Plugins are separate little 
programs which can communicate with KeyNote and extend its capabilities. For instance, a plugin could 
display a calendar or a to-do list, convert a note to HTML format, calculate text statistics, display a 
calculator or a unit converter, or run a spell-checker.

Plugins provide two significant advantages: they can be written by other software authors (using any 
compiler than can create Windows DLL files), and they add functionality to KeyNote without increasing 
the size of the main program. Plugins are loaded strictly on-demand and do not consume any memory or 
system resources when they are not active.

Currently (June 2001) KeyNote is distributed with a small set of example plugins. As more plugins are 
created, they will be available for download from the main KeyNote homepage; see the "Downloading 
Plugins" section, below.

Plugins are files with ".KNL" extension, and they must all be located in the "\plugins" subdirectory, below 
the directory where KeyNote is installed. For example, if KeyNote is installed in

c:\Program Files\Keynote
then all plugins should be placed in

c:\Program Files\Keynote\Plugins
This subdirectory is automatically created by the Setup program.

Plugins can be downloaded from KeyNote homepage. The currently available plugins should be taken as 
"proof or concept" only, but they all perform functions which have occasionally been requested by 
KeyNote users.

For information on how to use plugins, see "Using Plugins", below.

PLUGINS: GENERAL INFORMATION FOR DEVELOPERS

If you are a programmer (as well as a KeyNote user), you might like to create your own plugins. Plugins 
are DLL files, so you should be able to create plugins with any compiler that can create DLL, not 
necessarily Borland Delphi. I have prepared a separate package which contains detailed documentation, 
examples and source code to get you started. This "Developer kit" can be downloaded from

http://www.lodz.pdi.net/~eristic/free/kntplugins-dev.zip

If you need additional assistance beyond what's contained in the package, or if your plugin requires 
adding some functionality to KeyNote, please contact me at <eristic@lodz.pdi.net>.

Due to the limited space on my ISP account, I cannot promise that I will distribute all third-party plugins 
directly from my site. I will, however, be able to distribute a limited number of plugins, and I will always 
provide links to any useful plugins created by other developers.

USING PLUGINS

In KeyNote, there are two ways of using a plugin: by selecting it from a list of available plugins, or by 
activating the plugin that was used most recently.



I. To display a list of available plugins, click the "Plugins" tab on the Resource Panel (F9).

The tab contains a small toolbar with several buttons:

"Execute" button
- closes the dialog box and runs the selected plugin

TIP: You can also execute a plugin by double-clicking it.

"Configure" button
- runs configuration procedure for the selected plugin. Typically, this will display a dialog box that allows 
you to specify various options for the selected plugin, but because this procedure is created by the author 
of the plugin, KeyNote has no knowledge of or control over what the plugin does when this button is 
clicked. Note that some plugins may not support any configuration procedure.

NOTE: There will be a slight delay the first time KeyNote displays a list of installed plugins. This is 
because KeyNote needs to list all the installed plugins and ask each of them for name, description and 
status information before they can be displayed. Subsequent invocations of the dialog box will be faster.

TIP: Plugins can be added while KeyNote is running. KeyNote will not recognize this automatically, but 
you can force it to do so. To tell KeyNote that it needs to re-initialize the list of available plugins, right-click 
the list of plugins and select the "Refresh plugin list" command.

II. Repeating the most recently executed plugin: From the Tools menu, select the "Run last plugin" 
command.

INSTALLED SAMPLE PLUGINS

KeyNote is distributed with a small set of sample plugins.

Currently, these are:

"plugintest.knl"
Test plugin - a "bare-bones" plugin which does not do anything very useful but can be used for testing 
purposes.

"kncalendar.knl"
Displays a small dialog box with a drop-down calendar window, which allows you to select a date and 
insert it in the text of the active note. Date can be inserted in long (26 June 2001) or short (21-06-2001) 
format. The date format used is the format which you have set in Control Panel "International Settings" 
applet.

DOWNLOADING ADDITIONAL PLUGINS

Additional plugins are available for downloading from KeyNote homepage:

http://www.lodz.pdi.net/~eristic/free/keynote.html

Direct download links are located on the "Download" page.

Among others, there are scratchpad, key autorepeater, and Discordian Calendar plugins.

If necessary, I will later add a separate page for distributing (and linking to) plugins created by other 



software authors.

WHAT PLUGINS CAN DO

In general, a plugin can:

a) receive text from the note which is currently active
b) perform its function (Execute)
c) return some text back to KeyNote. KeyNote will insert that text in active note, or create a new note and 
insert the text there.

Both (a) and (c) are optional. This means that a plugin can, but does not HAVE TO receive or return any 
text.

An example of a plugin that receives and returns text would be a spell checker or an RTF-to-HTML 
converter. An example of a plugin which only receives but does not return text would be a plugin that 
calculates text statistics and displays information in its own dialog box. An example of a plugin which 
neither receives nor returns any text would be, well, just anything a programmer can think of :) For 
example, a plugin could run alongside of KeyNote and display a clock, a quote of the day, or even hints 
for using KeyNote that change as you work.

Further, plugins have some flexibility as to how they receive and return text. A plugin tells KeyNote what, if
any, format of text it wants to receive and what, if any, format of text it returns.

A plugin can RECEIVE:
a) no text
b) full text of active note, in RTF format
c) full text of active note, in plain text format
d) currently selected text in note, in RTF format
e) currently selected text in note, in plain text format

In addition, a plugin can specify that some text MUST be selected in order for the plugin to run. In that 
case, KeyNote will not run the plugin unless you select some text in active note first.

A plugin can RETURN:
a) nothing
b) RTF formatted text
c) plain text
d) dialog box text
e) clipboard data

For (b) and (c), the returned text will be inserted in currently active note.

For (d), KeyNote will display a dialog box with the text returned by the plugin. If you click OK in the dialog 
box, the text will be inserted in active note.

For (e), KeyNote will automatically paste clipboard data into active note, or display a dialog box informing 
you that the plugin has placed some data in clipboard. In the latter case, you can click OK in the dialog 
box to have the data pasted, or click Cancel to dismiss the dialog box and paste the data yourself 
wherever you want it.

TIP: You can specify in KeyNote's "Options" dialog box whether you want KeyNote to automatically paste 
clipboard data returned by plugins, or whether KeyNote should display the confirmation dialog box.

TIP: Clipboard data does not need to be text - this is why the clipboard option is provided to plugin 



authors. For example, a plugin could just as easily place a picture on the clipboard, which you could then 
paste into the note.

"RESIDENT" PLUGINS

Typically, a plugin will behave in a way similar to a normal dialog box: while the plugin is running, you 
cannot access the main KeyNote window, open any other dialog boxes, etc. There is no requirement for 
plugins to open any windows, but the principle remains: you cannot access KeyNote while a plugin is 
running.

However, a plugin author can create a special type of plugin which will be called "resident plugin" here. A 
resident plugin is "non-modal", which means that it can run alongside KeyNote and does not block access
to it in any way. For instance, a plugin could display a clock, and the clock would remain visible, in a 
separate window, while you wrk normally with KeyNote.

Resident plugins can (but do not have to) receive text from KeyNote as described in "What plugins can 
do", but they DO NOT return any text to KeyNote. You start a resident plugin and are immediatelt returned
to KeyNote. The resident plugin can shut itself down (after it has performed some operation, for instance) 
or can provide a user interface to close it.

You can run more than one resident plugin simultaneously, but you can only have one instance of any 
given resident plugin. If you try to execute a resident plugin which is already running, KeyNote will display 
an error message.

LIMITATIONS

Currently, plugins cannot control the operation of KeyNote itself. This may be added in the future if 
required by plugin authors.

A plugin can only receive or return text from and into the note which is currently active. For tree-type 
notes, this means that a plugin will only receive the text of the selected (active) tree node. Plugins do 
receive the name of the currently loaded KNT file, though, so nothing stops a plugin from reading the 
whole .KNT file and operating on it independently from KeyNote. A plugin also receives the name of the 
active note.

Currently, plugins do not receive any state information from KeyNote, or any information related to note 
trees, beyond what is specified above. In particular, a plugin cannot change KeyNote configuration 
options, open any KeyNote dialog boxes, run macros, etc.

A plugin COULD control the active RTF editor to an extent (e.g. it would be possible for a plugin to send 
Windows messages to the editor) but, in general, plugins should NOT attempt to do this, as there is no 
guarantee that a command can be executed. For instance, if the active note is read-only, commands 
dispatched from a plugin could modify it against the wish of ths user. And YES, it is possible to shut down,
or even crash KeyNote by issuing the wrong command or message from a plugin. Obviously, plugin 
authors should take care not to do so.
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Importing files as notes



Exporting notes to disk files
Individual notes or tree nodes can be exported to files in the following formats:
    plain text
    rich text (RTF)
    HTML
    TreePad

There are two separate sets of options which control how notes are exported. One set of options controls 
text, RTF and HTML export, the other set controls TreePad export.

The most important export settings are listed in the "Source and target" tab. These options apply to all 
target file formats. The tab contains two areas: "Source: What to export" and "Target: Where and how to 
export".

Source: What to export?

In this field you can select which note, notes, or part of a note you wish to export. The available settings 
are:
Current note - exports all or part of the currently active note
All notes - exports all notes in the current file
Selected notes - allows you to select which notes should be exported.

If you select the "Current note" option, and if the current note is a tree-type note, the following additional 
options are available in the drop-down list:
Current node - exports only the currently selected tree node
Current node and subtree - exports the currently selected tree node and all nodes which are its children
Checked nodes - exports all checked nodes in the current note
All nodes - exports all nodes in the current note
(When exporting more than one note, it is not possible to select groups of nodes, and the options above 
are unavailable.)

If you select the "Selected notes" option, you can click the "Select notes" button to specify which notes 
should be exported. A dialog box is displayed listing all notes in the current file. Check the notes you wish 
to export, and click OK to return to the "Export notes" dialog box.

Target: Where and how to export?

In this field you can select the format for exported files and the directory where the exported files should 
be placed. There are also two additional settings which control how the files are created.

To select the target file format:
Click the "Format for exported files" drop-down list, and select the format.

To specify the directory for exported files:
Click the button in "Directory for exported files" field, and select the directory. All exported files will be 
placed in the directory you select.

Additional options:
"Prompt before overwriting files" - if KeyNote wants to export a note using a filename that already exists, 
a warning is displayed, and you are given an opportunity to or change the filename. 
"Prompt for individual filenames" - Every time KeyNote exports a note to a file, a dialog box is displayed 
when you can accept the suggested filename, or enter your own. If this option is disabled, KeyNote 
automatically determines names for exported files and does not prompt you to confirm them.
Warning: If both these options are disabled, all filenames will be picked automatically, and existing files 



will be overwritten without asking for confirmation.

Exporting notes to plain text, RTF and HTML files:

Click the "Options" tab to review or change the option settings which control exporting to plain text, RTF 
and HTML format.

Note and node headings:
Each exported note and tree node can be optionally preceded by a heading that displays its name or 
other information. There are separate headings for notes and tree nodes. 

A heading is a single line of text which may contain one of several "tokens". A token is a single uppercase 
character preceded by te persent sign, e.g. %N. When a note is exported, the tokens are replaced with 
actual information. For instance, the %N token will be replaced with the name of the note being exported. 
Click the "Help on headings" button to display a dialog box with a list of available tokens and their 
meanings.

Usually, a note heading is inserted only once, at the beginning of an exported file. A node heading will be 
inserted before each exported node. To enable or disable the headings, click the corresponding 
checkboxes. To edit the headings, type in the text fields provided or click the drop-down lists to select a 
predefined heading.

Tip:
You can control the appearance (formatting) of the inserted headings. The formatting of the heading text 
depends on the contents of the following RTF files which are installed in the same directory as 
keynote.exe: notehead.rtf (formats the note headings) and nodehead.rtf (formats the node headings). 
You can edit these files in KeyNote (as virtual nodes) or in any RTF-compatible editor. Make sure that 
each file contains the token %HEADING and that the token is formatted consistently (i.e., do not make it 
half-bold or half-blue; the whole word, incuding the % character, must be formatted in the same way). You
can even enter some additional text there which will be inserted as part of the heading.

Exporting individual tree nodes:
When exporting tree-type notes, you can choose to export all nodes to a single file, or to export each tree 
node to a separate file. Select your preference in this field.

Important information about exporting to HTML:
KeyNote does not have its own RTF-to-HTML converter. Writing one is a difficult task. Instead, KeyNote 
relies on MS-Office converter library (html32.cnv and other associated files). These files must be present 
and correctly registered; otherwise KeyNote will not be able to export notes to HTML-formatted files. A 
better solution will perhaps be provided in version 2.0 of KeyNote. (Or, if you happen to be a Delphi 
programmer, I would certainly appreciate assistance in writing the converter.)

Exporting notes to plain TreePad files:

There are currently two editions of TreePad: the freeware edition supports only plain-text files, while the 
shareware edition supports plain text, RTF and HTML-formatted files. KeyNote files can be exported in 
format compatible with either the freeware or shareware edition of TreePad. (For more information, see 
www.treepad.comwww.treepad.com)

Click the "TreePad options" tab to review or change the option settings which control exporting to 
TreePad format.

To select the target TreePad edition:
Click the "TreePad options" tab, and in the "Target TreePad version" field select the format you need. 
Note that when you export to the freeware edition (plain text only), all text formatting will be lost, but the 
resulting file will be readable by both the freeware and shareware TreePad. If you export to the shareware



edition, text formatting will be preserved, but only the shareware edition of TreePad will be able to open 
the file.

Exporting multiple notes to TreePad files:
TreePad files can only hold one "note" per file, unlike KeyNote, where several notes can be contained 
within a single file. Therefore, KeyNote gives you a choice between exporting each note to a separate 
TreePad file, or joining several notes into a single TreePad file. If you choose the latter option, all 
exported notes will be placed within a single TreePad tree structure. To select one of these settings, click 
the "TreePad options" tab, and select an option in the "Target file mode" field.

Note: When exporting to TreePad format, it is not possible to select individual tree nodes or groups of 
nodes. Only whole tree-type notes (or simple, non-tree notes) can be exported.

Important note: TreePad file structure imposes a limitation tat KeyNote files do not have. A TreePad file 
can have only one top-level node (called "Master node" in KeyNote). All other nodes in the tree must be 
children of the top level node. In KeyNote, you can have as many top-level nodes as you wish. For 
example, the following tree structure is supported by KeyNote, but not supported by TreePad:

+ Top level node (level 0)
| - child node (level 1)
| - child node (level 1)
+ Another top level node (level 0)
| - child node (level 1)
In TreePad, the above tree structure is not possible: there can be only one 
"level 0" node. This becomes a problem when exporting a KeyNote tree with more
than one top-level node, or when exporting several notes to a single TreePad 
file. When KeyNote detects such a situation, it creates an additional, "dummy"
node, which is placed as the top-level node in the TreePad file, while the 
actual KeyNote notes are placed as children of the dummy node. For example, 
the above tree structure would be transformed into the following:

+ Dummy top level node (level 0)
+ - + Top level node (level 1)
    | - child node (level 2)
    | - child node (level 2)
    + Another top level node (level 1)
    | - child node (level 2)
The additional "dummy" node is filled with summary information derived from 
the KeyNote file being imported: the name of the file, the file description 
and comment, and the date the file was created.

By default, this additional top-level node is created only if necessary 
(KeyNote does not perform a full analysis, preferring to err on the side of 
caution, i.e., compatibility). You can force KeyNote to always create this 
additional node: click the "TreePad options" tab, and select your preference 
in the "Compatibility top-level node" field.





Customizing the toolbars
As of version 1.3.7, KeyNote offers a rudimentary toolbar customization. There is no graphical interface to
support this feature yet; all customization is done by editing a plain text file.

The file is called toolbar.ini and it resides in the same directory as keynote.exe (or in the same directory 
as keynote.ini, if you use an alternate location for the configuration file). You can edit the toolbar.ini file 
in any plain text editor, or directly in KeyNote, as a virtual node.

The toolbar.ini file is a standard Windows .INI file. It contains two sections: [MainToolbar] and 
[FormatToolbar]. These sections refer to the two main toolbars that can be customized; all other toolbars
in KeyNote are too small and too feature-specific to bother. Each section contains a list of button names, 
followed by the equal (=) sign and a digit: either 0 or 1. "0" means that the button will not be displayed; "1"
displays the button.

Once you have opened the toolbar.ini file in a text editor, all you need to do is decide which buttons you 
want to display and which to hide, and set the values to 0's or 1's accordingly. The button names should 
be self-documenting. 

Example:

If you want the big "Exit" button (the one with a thick red X on it) to disappear, find the line that reads
TB_Exit=1

and change it to
TB_Exit=0

If you want the "Print" button to become available, change the line
TB_Print=0

to
TB_Print=1

After you have edited the file, save it. 

Hint: You can configure the toolbars while KeyNote is running, and check your settings immediately. 
After you have saved the toolbar.ini file, return to KeyNote, click the "View" menu, select the "Toolbars" 
item, and then click the "Refresh toolbars" command. KeyNote will load the new settings and redisplay 
the toolbars.

To reset the toolbar state to factory defaults, simply delete the toolbar.ini file and then use the "Refresh 
toolbars" command, or restart KeyNote.



Customizing keyboard shortcuts
This dialog box allows you to change, add or remove keyboard shortcuts used to invoke KeyNote 
commands. You can modify the keyboard shortcuts for all commands listed in KeyNote's main menu and 
the right-click menu of the tree panel. (No other shortcuts can be modified.)

Tip:
If you want to assign keyboard shortcuts to plugins, macros, styles, fonts and templates, download and 
install the funckey.knl plugin.

To add or change an existing keyboard assignment:
Select a command in the "Commands" list. (The commands are listed alphabetically, but all tree-menu 
commands follow the main-menu commands.) Note that the description of the currently selected 
command and the currently assigned shortcut are displayed in the areas below the list.

Click the "New keyboard shortcut" field, and press the new key combination. If the key combination is 
valid, it will be displayed. Click the "Assign" button to accept the new keyboard shortcut.

Tip:
You can right-click the list of commands to change the way in which they are displayed. By default, each 
command is displayed as: menu name - command name. "Menu name" is the name by which the 
command is displayed in the menu. "Command name" is the internal name for the selected command (in 
some cases it will be more descriptive than the menu name). By using the right-click menu you can 
reverse this order.

To remove an existing keyboard assignment:
Select a command in the "Commands" list, and then click the "Remove" button.

Tip:
You can cancel the changes at any time by clicking the "Cancel" button.

To display a listing of all keyboard assignments:
In the dialog box, click the "List" button. This will generate an HTML document listing all currently 
assigned keyboard shortcuts, and will open the document in your default web browser. (The file is named 
keyboard.html and is saved in the same directory as keynote.ini. You may inspect this file later, outside 
of KeyNote.) The layout of the file is fixed, but the look is controlled by styles, defined in the file 
"keyboard.css". You can edit the CSS file to change the look of the keyboard listing.

To reset keyboard shortcuts to factory defaults:
In the dialog box, click the "Reset All" button, then click OK to confirm. Or, exit KeyNote and delete the file
"keyboard.ini" (ocated in the same directory as keynote.ini).

Limitations:

Only one keyboard shortcut can be assigned to each command.

Combinations of keys including Enter, Space, Tab, or Escape key cannot be assigned.

Some key combinations are reserved by Windows and cannot be assigned. These include, for instance, 
Alt+F4.

This dialog box can only be used to assign keyboard shortcuts to commands listed in main menu and in 
the tree panel right-click menu. Other keyboard shortcuts (e.g. those used in the Resource Panel) cannot 
be modified.



If you use the FuncKey.knl plugin to assign function keys to macros, plugins, styles, etc., settings made 
through the plugin will override shortcuts assigned here. For instance, if you assign Shift+F2 to the 
"Save As..." command in this dialog box, and also assign Shift+F2 to execute a macro (through the 
plugin), pressing Shift+F2 will execute the macro.

Some standard Windows keyboard shortcuts are built into the RTF editor and the treeview control. For 
instance, in the editor, pressing the right arrow key moves the caret one position to the right; pressing the 
Delete key erases the current character; pressing Ctrl+arrow jumpts to the next or previous word. These 
shortcuts cannot be modified.




